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1 IMPORTANT NOTES 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
This manual uses the following abbreviations as summarized in Table 1: 
 

Abbreviation Definition 
DEM Digital Elevation Model 
DSM Digital Surface Model 
DTM Digital Terrain Model 
GSD Ground Sampling Distance 
LUT Look-Up Table 
EO Exterior Orientation 
GCP Ground Control Points 
RPC Rational Polynomial Coefficient 

Table 1: Abbreviations. 
 
 

This symbol indicates a tip or helpful information. Following this advice will 
lead to better results and performance. 

This symbol indicates an important notice.  Failing to follow the notice could 
lead to unexpected or incorrect results. 

1 
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2 OVERVIEW 

Correlator3D™ software is a patented end-to-end photogrammetry solution for the generation of 
high-quality geospatial data from satellite and aerial imagery, including UAVs.  It builds on unique 
computer vision algorithms that significantly differ from traditional photogrammetry techniques.  
Powered by GPU technology and multi-core CPUs, Correlator3D™ ensures matchless processing 
power to support rapid production of large datasets.  
 
Correlator3D™ consists of the following modules: 
 
- Aerial Triangulation: exterior orientation correction and camera calibration 
- DSM Generation: generation of digital surface models and point clouds 
- DTM Extraction: extraction of digital terrain models 
- DEM Editing: editing of DEMs 
- Orthorectification: creation of orthophotos and true orthos 
- Mosaic Creation: stitching orthophotos together creating a mosaic 
- Mosaic Editing: editing of mosaic seamlines 
- 3D Model Generation: generation of textured 3D models 
- Gaussian Splat Generation: generation of Gaussian splat models 
- Gaussian Splat Editing: editing of Gaussian splat models 
- Feature Extraction: semi-automated collection of 3D features 
 

 
DSM 

 
DTM Mosaic 

 

Point Cloud 
 

3D Model Gaussian Splat Model 
 

Figure 1: Sample geospatial data. 
 
 
The software also provides other tools including: 

 
­ Automated Workflow: automatic execution of Correlator3D™ workflow 
­ Data Sharing: upload and share results using Cesium 
­ Flight Line Editing: remove images from project and modify flight lines 
­ GCP File Creation: semi-automatic tool for creating and editing GCPs 

2 
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­ Index Map Creation: computation of predefined or custom indices 
­ Change Detection: identification of 3D changes 
­ DEM Merging: stitching of DEM patches 
­ DEM Inspection: generation of statistics about DEM quality 
­ Point Cloud Filtering: filtering based on the number of observations 
­ Point Cloud Colorization: colorization of a point cloud using a mosaic 
­ DEM Contour Extraction: extraction of contour lines from a DEM 
­ Volume Calculation: measure a volume from a DEM 
­ Pansharpening: pansharpen satellite images 
­ Splat Model Merging: stitching of splat models 

 
 
The following sections describe, in detail, the different functionalities, uses, and guidelines of the 
software, to ensure optimal results. 
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3 SYSTEM REQUIREMENTS 

Correlator3D™ has been designed to operate on standard PCs.  However, it consists of state-of-
the-art software and as such, requires a recent computer.  A great portion of the processing is 
performed directly on the graphics card, which is part of what allows Correlator3D™ to generate 
geospatial data so rapidly.  The supported cards must feature an NVIDIA, AMD or Intel graphics 
processor that is OpenCL-enabled. 
 
Processing can also be performed on a PC that does not have a GPU, as long as the CPU is OpenCL-
enabled. However, the corresponding drivers may need to be installed, and the performance will be 
significantly reduced. 
 
It is therefore recommended to use Correlator3D™ on a PC that meets or exceeds the specifications 
in Table 2: 
 
 

Component Description 
CPU Intel® Core™ i5 processor or higher 
GPU Graphics card with an NVIDIA® GeForce 9 GPU (G92) or higher, with 1GB RAM 

or higher (note that most Quadro, Tesla, and Tegra cards also feature a GeForce  
GPU), or with an AMD Radeon™ R9 GPU or higher, with 1GB RAM or higher. 
NVIDIA® GPU required for Gaussian splat generation. 

RAM 8GB or higher. 
OS Windows 10 and 11. 

Table 2: Recommended specifications for running Correlator3D™. 
 
 
 

3 
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4 DATA REQUIREMENTS  

Correlator3D™ requires different types of data to be able to perform its processing and can produce 
several kinds of outputs.  As a result, it expects and generates data using specific data types. Table 
3 summarizes the supported file formats.  
 

Data Type Supported Formats File Extensions 
DEM SimActive Model Format (SAMF) 

GeoTIFF 
Arc/Info ASCII Grid 

.smf2, .smf 

.tif 

.asc 
3D Constraint ESRI Shapefile  

Microstation DGN 
.shp 
.dgn 

Image Types TIFF / BigTIFF / GeoTIFF 
JPEG Compliant 
JPEG2000 
Windows Bitmap 
NITF 
IIQ 

.tif 

.jpg 

.jp2 

.bmp 

.netf 

.iiq 
Mosaic Definition File SimActive Format .sbd 
Tile Definition SimActive Format .tdf 
Ground Control Points SimActive Format .gcp 
Orthorectified Images GeoTIFF (BigTIFF) 

TIFF (BigTIFF) World Format 
.tif, 
.tif, .tfw 

Support File for ADS SOCET SET support file .sup 
RPC for Satellite RPC Model file .rpc, .rpb, .xml, .txt 
Image Tiles for Satellite Tile Model file 

DIMAP 
.til 
.xml 

SimActive Script SimActive Script Format  .spt, .txt 
Geoid GTX Format 

TIFF / BigTIFF / GeoTIFF 
.gtx 
.tif 

Project File SimActive Format .c3d 
3D Features ESRI Shapefile .shp 
3D Model SimActive 3D Model Format 

OBJ Format 
.tmf 
.obj 

Point Cloud LIDAR LAS 
LIDAR LAZ 

.las 

.laz 
Contours ESRI Shapefile 

AutoCAD 2000 DXF 
.shp 
.dxf 

Interior/Exterior 
Orientation File 

SimActive Format .ieo 

Calibrated Reflectance 
Panels 

SimActive Format .crp 

Gaussian Splat Model Polygon Format 
Compressed Polygon Fomat 
Gaussian Splat Format 

.ply 

.compressed.ply 

.splat 
Table 3:  Supported file formats. 

 
 
 
 

4 
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4.1 Sensor Types 

Correlator3D™ supports the following types of sensors: 
 UAV / Medium / Large format camera systems 
 Multispectral camera systems with unregistered bands 
 Satellite sensors using the RPC model 
 Leica’s ADS pushbroom sensors 

 
These four sensor types function in a similar manner, but require different parameters when creating 
a project. The following flowchart describes the workflow of Correlator3D™. Note that the 
workflow is sensor-dependent. 
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Figure 2:  Correlator3D™ workflow. 

 

Project Creation 

Aerial Triangulation 

DSM Generation / Point Cloud 

DTM Extraction 

UAV/Medium/Large Format 

DEM Editing 

Mosaic Creation 

Orthorectification 

Mosaic Editing 

Project Creation 

Satellite ADS 

Project Creation 

Feature Extraction 

3D Model Generation 

Gaussian Splat Generation 
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4.2 Input Image Formats 

4.2.1 Formats 

Supported formats are summarized in Table 4. 
 

Image Type Data Format 
TIFF, BigTIFF and GeoTIFF 8, 16 or 32 bits per band 

1 to 32 bands 
Single page or multipage 

JPEG in TIFF 8 or 12 bits per band 
1, 3 or 4 bands 
Single page or multipage 

LZW  in TIFF 8, 16 or 32 bits per band 
1 to 32 bands 
Single page or multipage 

JPEG 8 bits per band 
1 or 3 bands 

R-JPEG 16 bits per band 
1 band 

JPEG2000 8 or 16 bits per band 
1, 3 or 4 bands 

IIQ 16 bits per band 
3 bands 

NITF 8 or 16 bits per band 
1, 3 or 4 bands 

Windows Bitmap 8 bits per band 
1, 3 or 4 bands 

Table 4: Supported input image formats 
 

TIFF and GeoTIFF images are supported in both interleaved (RGBRGB) and pixel ordered 
(RRGGBB) formats. 

When an input image is detected as an R-JPEG, Correlator3D™ reads and processes only 
the radiometric thermal data, treating the image as a single-channel (thermal) image. 
The thermal values are read as 16-bit integers representing tenths of degrees Celsius 
(0.1 °C). Internally, these values are converted to tenths of Kelvin (0.1 K) to ensure all 
values remain positive. When exporting a mosaic, selecting the Thermal export format 
converts the data back to floating-point temperatures in degrees Celsius (°C). 

 

4.2.2 Unregistered Bands 

Correlator3D™ supports unregistered bands generated by multispectral or similar types of sensor. 
These sensors usually feature different imagers (and lenses) that are not registered or aligned 
mechanically. The software will register the different bands automatically during tie point extraction. 
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4.3 DEM Format 

The DEM should have square cells for all formats.  This means that cell dimensions in X and Y should 
always be the same.  Also, elevation values in GeoTIFF files should be expressed as 32-bit floating 
point numbers.  
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4.4 Orthophoto Format  

Orthophotos can be generated in the Tiled TIFF format with overviews to maximize system 
performance during their subsequent exploitation using GIS software.  Orthophotos are produced 
in one of the following formats: 
 

­ 8, 16 or 32 bits per band 
­ 1 to 32 bands 
­ JPEG compression or no compression 
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4.5 Vectors 

Existing vectors can be supplied to the software for different purposes. They can be used as 3D 
constraints for the DSM generation and DTM extraction modules to force specific elevation values 
in the output DEM. They can also be used as an input to the orthorectification process to generate 
true orthos. Vectors can also be used as a reference in the software. For example, some projects 
can be divided in multiple blocks. Having an overlay displaying a reference can then be useful to 
guide the editing process. 
 
Vector files must be provided in the ESRI Shapefile or Microstation DGN and contain points, lines 
or regions. If vectors are to be used as a 3D constraint but that the features do not have elevation 
data (z-component), users will be prompted to specify a default elevation value or to specify the 
name of the attribute to get the elevation from (e.g. “HEIGHT”). 
 

 
Figure 3: Vector elevation dialog. 
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4.6 Coordinate Systems  

Correlator3D™ requires the projection to be specified when creating a project. The user specifies 
the projection details as shown in Figure 4.  
 

 
Figure 4: Projection dialog. 

 
Four options are presented to the user.  A predefined list of the most common projections is 
available.  Otherwise, the user may search for a specific projection system by entering the 
corresponding keywords or EPSG code. The user can also specify a custom projection or specify a 
Proj.4 definition.  If using the Proj.4 option, please refer to this website for specific values: 
http://spatialreference.org/ 
 
Although mandatory for satellite and ADS sensors, the projection is optional for UAV/medium/large 
format sensors, and can be ignored by pressing the “Ignore” button as shown in Figure 4.  Note that 
the rotation system supported by Correlator3D™ is photogrammetric (omega, phi and kappa) and 
that the geographic coordinate system (i.e. latitude/longitude) and navigational angles (i.e. roll, pitch 
and yaw) are converted when importing EO data during project creation.  If the user chooses to 
ignore the projection, then no projection information will be saved in the GeoTIFF files. 
 

Proj.4 values representing a geographic coordinate system (latitude/longitude) are 
not supported. 
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5 VISUAL INTERFACE 

Correlator3D™ is designed for ease of use, featuring a simple visual interface. The main 
window serves to load, save, and display DEMs, point clouds, mosaics, orthos, Gaussian 
splat models, images, GCPs, vectors, contours and AT results. Additionally, it provides 
access to the different software functionalities and tools. At the core enabling this user 
experience is the project tree, further described in the corresponding section. 
 

 
Figure 5: Correlator3D™ main window. 

 
 

5 



Visual Interface | 19 

5.1 Multilingual User Interface 

Correlator3D™ can be operated in different languages, including English, French, Portuguese, 
Spanish, Japanese, and Chinese. The user can select the language at any time by accessing the 
corresponding option in the General Settings dialog from the File menu. Note that the language 
change is only applied once the software is restarted. 
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5.2 Color Mode 

The software features a color mode option that allows users to customize the appearance of the 
user interface to their preferences. Users can choose between a dark or light color scheme or set it 
to match the current Windows setting. The dark mode is particularly useful for working in low-light 
environments or reducing eye strain, while the light mode offers a brighter interface for working in 
well-lit environments. Setting the color mode to match the Windows setting ensures consistency 
with other applications and can be especially helpful for users who switch between different 
software frequently. To change the color mode, users can easily access the general settings of the 
application and select their preferred option. 
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5.3 Project Tree 

The project tree displays the project information as a hierarchical structure on the user window. The 
tree is used to perform multiple functions: modify the visibility of an overlay using a checkbox, save 
results, add data to the project, etc. It allows the user to seamlessly transition between data within 
each project. When the cursor is placed above an item listed in the project tree, contextual buttons 
appear. The following subsections describe each aspect of the project tree. 

5.3.1 Images 

At the top of the project tree are the “Images”. This item is filled with parameters given during the 
project creation. When selecting the “Images”, the camera(s) used in the project appear with their 
corresponding image footprints if a DEM is loaded. It is possible to have more than one camera 
within each project, and consequently, within the project tree.  
 
Expanding the camera node will allow the user to see its associated flight line(s). The user has the 
option to select which flight lines or images are to be processed in corresponding steps using the 
contextual buttons. With this, flight line and images can be disabled; they will not be considered 
while generating a DSM or orthos. Moreover, the checkboxes are used to toggle visibility in the 
main window of the corresponding item (image, flight lines, or complete image set). 
 

In the AT module, all images included in the project are considered; enable/disable have 
no impact and cannot be changed in this mode. 

 
When a DEM is loaded, the image footprints on the ground are displayed. This function can 
be turned on and off at the user's preference. 
 

When images are selected using the tree, the image positions are displayed as arrows overlaid on 
the DEM.  This is very useful when ensuring that both the imagery and 3D data span the same 
region.  Note that each arrow indicates the top of the image.  Flight lines and their direction are also 
displayed as dashed lines with arrows. 
 

When the cursor is placed over an arrow, a tooltip shows the name of the corresponding 
image. The user can also right-click on the image position to display the image in a 
separate window. The image will be rotated following its kappa-angle value. Panning is 
performed by clicking and dragging with the middle (wheel) mouse button while zooming 
can be performed using the mouse wheel. Note that several  images can be displayed 
simultaneously. 

 

Within the aerial triangulation module, the arrows may be replaced by color disks to 
allow a quick assessment of the quality of the bundle adjustment process. Please refer 
to section 7.1.6 for details. 
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Figure 6: Image window. 

5.3.2 GCP 

An existing GCP file can be added to the project directly using the project tree. There is also the 
option to remove the GCP file from a project. In order to create a GCP file, the user can go into the 
AT module. Similar to the aforementioned option, the project tree can be used to toggle the GCP 
visibility using the checkboxes. 
 
Correlator3D also allows the user to specify check points. GCPs and check points are stored in the 
same GCP file, but the project tree displays them in two distinct subcategories of GCPs. GCPs and 
check points are only considered when performing bundle adjustment, but can be used to visually 
assess quality of the DSM, DTM, and mosaic. Please refer to sections 7.1.3 and 11.5 for further 
details. 

5.3.3 Calibrated Reflectance Panels 

An existing calibrated reflectance panel file can be added to the project directly using the project 
tree. There is also the option to remove the file from a project. In order to create a panel file, the 
user must add one by one the reflectance panels with their respective images. Note that this section 
of the tree is only available with multispectral frame-based projects. Please refer to section 11.5 for 
further details. 

5.3.4 AT 

Please refer to section 7.1 for details. 
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5.3.5 DEM 

The project tree simplifies working with DEMs as a DEM can be loaded directly onto it. Select “Add 
a DEM to project”, by placing the cursor over the “DEM” item in the project tree. More than one 
DEM can be a part of the project. However, at any given time, only one DEM can be displayed. The 
ability to toggle between multiple DEMs is possible through the project tree using the checkbox for 
each DEM. It is also possible to remove a DEM by clicking on the “X” when placing your mouse over 
the respective DEM. 
 
Once the data is read, it will be displayed in the window. Two display styles are available for viewing 
elevation data: color and grayscale. If the color display style is selected, elevation values are mapped 
from blue to red (through green and yellow) according to the minimum and maximum values found 
in the data: low elevation values will be displayed in blue or green, middle values in yellow and high 
values in red. If the grayscale display style is selected, elevation values are linearly mapped from 
black to white according to the minimum and maximum values found in the data: low elevation 
values will be displayed in dark colors while high values will appear in light colors. 
 
The display style can be changed by selecting “Display Style->Color” or “Display Style->Grayscale” 
in the “View” menu. 

 
Colors can be mapped from the minimum and maximum elevation values visible on the 
screen.  The latter case is called “stretch” mode and can be enabled or disabled by selecting 

“Display Style->Stretch” in the “View” menu. 
 

Subtle variations in elevation values can be highlighted by selecting the “Shade DEM 
variations” feature, which simulates lighting and shadows. This feature can be enabled or 

disabled by selecting “Display Style->Shade” in the “View” menu. 
 
When a DEM file is loaded, a legend is visible at the left of the main window. This legend shows the 
color mapping currently used for displaying the elevation data. Minimum and maximum values are 
displayed with a line indicating the “0” value, if relevant. When the cursor is moved over the DEM, 
a horizontal bar moves up and down over the legend providing a visual cue for the elevation under 
the cursor. Precise elevation and coordinates of the location under the cursor are available in the 
right part of the status bar. The legend can be shown or hidden by selecting “Legend” in the “View” 
menu. 

 
DEMs can be saved by clicking the contextual button in the tree. 

 

5.3.6 Point Clouds 

Point clouds are displayed under the “Point Cloud” section of the tree. The user can toggle their 
visibility by using the checkbox. Points clouds can be also be added by selecting “Add a point cloud 
to project”, by placing the cursor over the “DEM” item in the project tree. It is also possible to directly 
delete a point cloud from the project by hovering over the corresponding item and clicking on the 
“X”. 

5.3.7 3D Models 

3D models are displayed under the “3D Model” section of the tree. The user can toggle their visibility 
by using the checkbox. 3D models can be also be added by selecting “Add a 3D model to project”, 
by placing the cursor over the “3D Model” item in the project tree. It is also possible to directly 
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delete a 3D model from the project by hovering over the corresponding item and clicking on the 
“X”. 
 
The user can also modify the way the 3D model is being displayed. If the model has a texture, its 
visibility can be toggled. It can also be displayed as a wireframe. These options can be accessed in 
the “3D Model Display Style” section of the “View” menu. 

5.3.8 Splat Models 

Gaussian splat models are displayed under the “Splat Models” section of the project tree. The user 
can toggle their visibility using the checkbox. Splat models can also be added to the project by 
selecting “Add a splat model to project” from the corresponding contextual button. It is also possible 
to remove a splat model from the project by hovering over the item and clicking on the “X”. 
 
When a splat model is enabled, the software automatically switches to the Gaussian Splat Editing 
mode. This dedicated viewing mode is specifically designed for splat data and ensures optimal 
visualization and interaction. 
 
In this mode, the splat model is displayed independently to provide a clear and focused view of the 
data. 

5.3.9 Orthos 

With the project tree, the user can toggle the visibility of each generated ortho with its checkbox. 
It is possible to directly delete all the orthos from the project by hovering over the “Orthos” item on 
the project tree and clicking on the “X”. The user can also specify a new or existing folder for orthos. 
In order to do this, place the mouse over the “Orthos” and select the “+” icon to open or set a new 
ortho folder. Note that generating orthos without specifying a new folder will delete the previously 
stored orthos from the folder. 
 
The user has the option to select which orthos are to be processed in mosaic creation using the 
contextual buttons. With this option, orthos can be disabled; they will not be considered while 
generating a mosaic. 

5.3.10 Mosaic 

The user can toggle the visibility of the mosaic using the project tree by using the checkbox. It is 
possible to directly delete the mosaic from the project by hovering over the “Mosaic” on the project 
tree and clicking on the “X”. The user can also specify a new or existing folder for the mosaic. In 
order to do this, place the mouse over the “Mosaic” item and select the “+” icon to open or set a 
new mosaic folder. Note that generating the mosaic without specifying a new folder will delete the 
previously stored mosaic from the folder. 

5.3.11 Vectors 

Vectors in a project are divided into two categories: Features, and References. Features are 
associated to 3D constraints and user selections and can be edited in the DEM Editing, Volume 
Calculation and Feature Extraction modules. The user can toggle the visibility of the different 
vectors using the corresponding checkbox. References are used to guide the user and serve to ease 
any aspect of the production, mostly editing. They can contain any type of vector, including project 
division, waterbodies, etc. 
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5.3.12 Reference Orthos 

Reference orthos are orthos that were created outside of a project and are used for quality 
assessment. The AT module can also use the reference orthos along with a DEM as horizontal and 
vertical reference data when GCPs are not available. 
 
The functionality of the tree view with respect to the reference orthos is the same as the one 
described in section 0. Note that disabled reference orthos will not be considered while performing 
a bundle adjustment with reference imagery. 

5.3.13 Contours 

The user can toggle the visibility of the generated contour lines using the project tree and its 
checkbox. Existing contours can be added by placing the cursor over the “Contour” item in the 
project tree and selecting “Open contour”. Note that more than one contour can be part of the 
project. It is also possible to remove a contour by clicking on the “X” when placing your mouse over 
the respective contour item. Contours can be saved by clicking the contextual button in the tree. 
 
When a contour is selected using the tree, it is displayed as lines in the main window.  Hovering the 
cursor over a specific line will pop up the corresponding elevation. It is also possible to click on a 
specific line to highlight it. 

5.3.14 Online Data 

If a projection was specified during the project creation, the user can toggle the visibility of online 
data. These data are automatically downloaded from the internet and can help assess the 
geolocation of the project. Online data can be either satellite imagery, maps, terrain data, or hybrid. 
These options can be selected directly from the tree or from the “Online Data Style Option” in the 
“View” menu. 
 

 



Visual Interface | 26 

5.4 Properties 

The project tree includes a window that displays the properties of a selected object (e.g. GCP, 
camera, images, DEM, orthophotos). The tool is beneficial as it assists in the assessment of metadata, 
such as the camera calibration, image position, GCP type, etc. The information the property window 
displays is dependent on the type of object selected.  
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5.5 Zooming and panning 

The main window of Correlator3D™ supports advanced zooming and panning capabilities.  Data 
caching and automatically triggered refreshes are performed to offer both rapid and fluid response, 
while displaying the most accurate information available. Fast results are obtained even for huge 
projects at low memory costs. When working with large files, hard disk performance can limit the 
speed at which information can be displayed. In such situations, Correlator3D™ will temporarily 
display a less accurate version of the data while it is being loaded. The accurate version will be 
displayed shortly afterward, as soon as available. 
 

This allows the user to continue panning and zooming while data loading is performed 
and ensures a fast response at any given moment. 

 
Panning is performed by clicking and dragging with the left or middle (wheel) mouse buttons. 
Zooming can also be performed using the mouse wheel, as well as the Ctrl + and Ctrl − keyboard 
shortcuts. 

Note that during DEM editing, only the middle (wheel) button is supported for 
panning.  

 
Zooming can be performed in multiple ways. The simplest and most intuitive way is to use the mouse 
wheel. If the mouse does not include a wheel, the options “Zoom->Zoom In” and “Zoom->Zoom 
Out” in the “View” menu will provide the same results. 

 
The “Zoom to region” feature lets the user specify a rectangular area. Zoom and pan 
operations are then computed to show the selected area as large as possible and centered 

onscreen. The “Zoom to region” feature is available by selecting “Zoom->Zoom to region” in the 
“View” menu. 
 

At any time, the user can return to the default view by selecting “Zoom->Home” in the 
“View” menu. The default view displays the entire project centered onscreen. 
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5.6 Image Band Setup 

The Image Band Setup dialog allows the user to select which band of the image to use for 
each color channel (red, green and blue). This allows to analyze multi-spectral imagery in 

many ways. To view just a single band, the same band can be selected for all three channels. Default 
black and white bands are also available to provide other combinations. Note that the configuration 
can be set independently for each layer of the project (input imagery, orthos, mosaic, etc.). 
 

 
Figure 7: Image band setup window. 

 

For projects with unregistered bands, displaying images before band registration (which 
is performed automatically during tie point extraction) can lead to blurry images. 
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5.7 Picture-in-Picture 3D Viewing 

Correlator3D™ features picture-in-picture (PiP) 3D viewing capability.  The PiP brings a 3D rendered 
view of projects through an inset window, visible at all times to streamline processing and editing. 
The interactive viewing capability allows display of image locations and associated viewing 
pyramids, as well as DSMs, DTMs, point clouds, orthophotos and mosaics.  Ground control points, 
check points, and aerial triangulation results are displayed in 3D to facilitate quality control. The PiP 
allows a 3D visual assessment of data and results throughout the entire production workflow, 
including real-time modifications displayed during DEM editing. 
 
The PiP window always reflects in 3D what is currently displayed in 2D in the main view. For 
example, zooming in the main window will result in cropping the data shown in the 3D view. 
Therefore, users willing to inspect a feature in more detail should first zoom in the main window, 
and then interact with the PiP window. 
 

At any time, the 2D and 3D views can be swapped by pressing the corresponding button in 
the toolbar. 
 

The size of the PiP window can be set to small, medium, or large in the in “View->3D View” menu. 
Users can also have the 3D view in its one window by selecting “3D View->Window” in the “View” 
menu. 
 
Rotation in the PiP window is performed by clicking and dragging with the left mouse button. 
Zooming can be performed by using the mouse wheel, while panning is done by clicking and 
dragging with the middle (wheel) mouse button. The left button of the mouse can be used to select 
an object like an image pyramid to see its footprint. 
 

Users can always reset the view point to its original state using the corresponding button in 
the toolbar. 

 
Elevation values of objects being displayed in the 3D view can be exaggerated or 
suppressed to facilitate data analysis. To achieve this, users can repeatedly press the 

corresponding buttons in the toolbar. 
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5.8 Scale 

The user can also zoom the current view to a specified scale.  For example, to make 1 centimeter on 
the screen to be equivalent to 1 kilometer of ground truth, one would enter a scale of 100,000 (this 
is the number of centimeters in a kilometer). 
 
A scale indicator is located near the bottom of the legend. The indicator can be shown or hidden by 
selecting “Scale” in the “View” menu. The scale is dynamically adjusted during a zoom operation. 
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5.9 Status Bar 

The status bar provides various types of information, including the sensor type, the DEM horizontal 
resolution, the coordinates of the cursor and the elevation at the cursor’s location. The sensor type 
is either “UAV/Medium/Large Format”, “Satellite” or “ADS” and indicates the current project type. 
The DEM resolution displays the resolution of the DEM written in the file. Unlike the scale, it is 
invariant to zooming operations. Coordinates are refreshed while the cursor is moved over the DEM 
and the elevation under the cursor is displayed only when available. The status bar can be shown or 
hidden by selecting “Status Bar” in the “View” menu. 
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5.10 Profile 

The Profile tool generates a vertical profile of the DEM over a user-specified path. The path 
consists of a series of connected linear segments.  Once a path is specified, Correlator3D™ 

opens a new window containing the vertical profile. The profile is generated by sampling the DEM 
and contains two different representations simultaneously. 
 
The first representation is an area chart shown in light blue. It shows the real elevation value for 
each sample based on a nearest neighbor approach for samples falling between two values of the 
DEM. It provides a discrete representation that is well-suited for visualizing surfaces that are highly 
non-continuous (e.g. urban areas). 
 
The second representation is a smooth dark blue line super-imposed over the previous 
representation. This time, a bilinear interpolation technique is used to obtain the sample values. The 
representation is better suited for visualizing areas where the terrain is continuous (e.g. rural areas). 
 
In the profile windows, vertical blue lines show the delimitation of each linear segment of the path. 
 
When the mouse is moved over the profile, a blue circle located on the interpolated profile follows 
the mouse motion. XY coordinates and elevation values associated with this blue circle are 
automatically updated and shown in the lower right corner of the profile window. A similar circle 
appears and moves synchronously in Correlator3D™’s main window over the user-specified path to 
show the exact location corresponding to the mouse position in the profile view. 
 
A “stretch” button located in the status bar enables or disables the stretch mode. When enabled 
(default), the profile is stretched to take the entire size of the window, but the aspect ratio is not 
respected. When disabled, square aspect ratio is used, ensuring that the same number of pixels in 
the x or y dimensions correspond to the same physical dimension in DEM units.  
 
By right-clicking on the profile, the user can save an image of the profile in a file or to the clipboard. 
 

 
Figure 8: Profile window. 
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5.11 Volume 

The Volume tool measures a volume over a user-specified selection and a reference 
elevation. The user begins by selecting the areas in which the volume is to be calculated. 

The functionality related to the selection is similar to the DEM Editing module. Please refer to 
section 7.4 for details. 
 
Once areas are specified, the user clicks on the corresponding button to open the Volume window 
and selects a reference elevation for the volume to be computed. There are five types of reference 
elevations: 
 

­ Interpolate DEM at polygon boundary: obtain volume by interpolating DEM values present 
at the chosen boundary 

­ Interpolate polygon elevation: obtain volume by interpolating elevation values defined in 
each polygon vertex 

­ Use fixed elevation: obtain volume from a specified height  
­ Remove constant offset (dig): obtain volume by removing an offset value 
­ Add constant offset (fill): obtain volume by adding an offset value 
­ Use reference DEM: obtain volume by selecting a reference DEM 

 
These options give the user flexibility in the volume type they can calculate. 
 
The following statistics appear in the properties windows on the left once the process is complete: 
 

­ Volume (Cut): the volume measured between the reference elevation, and the terrain above 
­ Volume (Fill): the volume measured between the reference elevation, and the terrain below 
­ Terrain area: the area covered by the selection, considering the terrain morphology. This 

can be visualized as the size of the sheet you would require to drape the terrain 
­ Orthogonal area: the area covered by the selection, not considering the terrain elevation 
­ Volume coverage: percentage representing the coverage of the selection used to measure 

the volume, with no consideration for the undefined elevation values. The user should 
ensure that this value is always close to 100%. The value may indicate that the reference 
DEM being used does not overlap completely with the current DEM, or that the software 
was not able to completely interpolate at selected boundary (because too many vertices 
were falling outside the model). 

 
 

 
Figure 9: Volume window. 
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5.12 Data Source Identification 

The Data Source Identification tool can be used to identify which image, ortho, or DEM tile 
was used to generate a specific product at a specific location. This is particularly useful to 
better understand why an undesirable feature appears in a DSM or a mosaic for example 

and identify its origin. More specifically, when users click on a location using this tool in the main 
view, the Data Source Identification window will present the following information: 
 

­ DEM Tiles: the list of temporary DEM tiles, with their respective elevation, used to generate 
the final DSM at this location. These tiles can be found in the temporary folder as described 
in Section 15.3. A strategy to merge back the tiles, excluding the ones that are undesirable, 
is also explained. 

­ Mosaic: the list of orthos, with their respective color value, used to generate the mosaic at 
this location. Having more than one ortho means that the location is within a feathering 
(transition) zone between two or more orthos.  

­ Orthos: the list of orthos for which the footprint contains the selected location.  
­ Images: the list of images for which the footprint contains the selected location. Note that 

a DEM must be loaded. 
 
Note that clicking on an ortho/image from these lists will automatically select the corresponding 
item in the project tree. Consequently, it can be disabled using the contextual button, excluding it 
from any further process. 
 
 

 
Figure 10: Data source identification window. 
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6 PROJECT CREATION 

 
The simplistic design and interactive user interface is made possible through the creation, and use, 
of projects. A project within Correlator3D™ consists of a file with information about the location of 
all the input and output data: EO data, camera calibration, AT data, projection, images, DEMs, GCP, 
orthos, mosaic, reference orthos and vectors. The purpose of the project is to centralize information 
for ease of use. Part of this information must be specified during project creation. 
 
The project creation wizard is used to create a project in Correlator3D™. As the wizard incorporates 
all supported sensor types, the user does not have to be concerned with the specific sensor type for 
the full photogrammetry workflow. A project type must be simply selected from one of five options, 
and proceed with the required steps. 
 
Once a project has been created, it can be closed and accessed at a later time. A project can be 
moved from one location to another, as long as the file hierarchy is preserved on disk (e.g. one folder 
with the project file and all images, orthos). 
 
To save the main file of a project, the user can select “Save Project As” within the File menu. This 
will not change or move the other files, only the main one. 
 
There are four types of projects differentiated by the sensor type and image size: UAV, 
Medium/Large Format, Satellite and ADS. The following sections describe the steps to create a 
project for each of the listed project types. As the UAV and Medium/Large Format project types 
only differ in image size, they are grouped together. 
 
 

 
Figure 11: Project type. 
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6.1 UAV / Medium / Large Format 

The UAV/medium/large format imagery refers to digital images and scanned films. The difference 
with each is based on the image size. The UAV format is used for digital images smaller than or equal 
to 50MP. The medium/large format is used for images greater than 50MP, and for scanned films. 
 
UAV/medium/large sensor the user should ensure that the overlap between adjacent images is 
appropriate to ensure optimal results. The endlap (i.e. the overlap between successive images) 
should be at least 60% of the image size, but also should be as close as possible to that value. In 
terms of the sidelap requirements (i.e. the overlap between images from adjacent flight lines), it is 
recommended to use a value between 20% and 30%.  Note that for low-altitude flights, the endlap 
should be approximately 80% and the sidelap 50% to minimize occlusion effects from one image to 
the other. 

6.1.1 Step 1 – Camera Configuration 

While most setups only consist of a single camera, more than one camera can be added to a project. 
If there is more than one camera, those cameras can either belong to the same group (e.g. a multi-
head camera systems), or to different groups (e.g. an area was flown by two different cameras that 
are not attached together). This can be performed by specifying the number of cameras, and the 
number of groups, and then associating each camera to its group using the table. Note that the name 
of each camera can also be changed in this table.  
 
A camera can also consist of more than one imager. This is the case for multispectral cameras where 
each frame consists of several bands that are not aligned together. The user must then check the 
“Unregistered Bands” option. Note that even if a camera consists of several imagers, it is still 
considered as a single camera. 
 

The band registration process will be performed automatically during the tie point 
extraction.  

 
Depending on the number of cameras, the wizard will cycle through the “Image Selection” and 
“Camera Parameters” steps iteratively. 

6.1.2 Step 2 – Image Selection 

The selection of images to be processed in the project is done by adding the images and their 
corresponding EO data in the wizard. Images can be added individually, or through a complete folder 
using the appropriate button. Once they are added, the software automatically requests EO data 
(please refer to section 11.1 for further details). If EXIF information is present, the software can use 
it to generate the EO data, though it is not mandatory. The user has the option to import a text file, 
or a legacy SimActive EO file. Projection information is defined after this dialog (please refer to 
section 4.6 for further details). 
 
The user can remove all selected images using the “Clear” button, choosing a new set of images 
instead. Specific images can be removed from the dataset using the “-” button on the right of the 
list of selected images. 
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The workflow is different when the “Unregistered Bands” option was checked in the “Camera 
Configuration” step. If the sensor is natively supported, the user can simply select all images from 
all bands and the software will automatically organize them in a table where each line corresponds 
to a frame, and the columns to its different bands. Otherwise, the user can select images band per 
band and the software will ask how to integrate them to the list (e.g. append them to an existing 
band or create a new band). Note that it is very important to make sure that all lines contain the 
right images/bands to ensure frame consistency.  Once all images are added, the name and index of 
all bands can be modified by pressing the “Edit bands...” button. A master band can also be selected. 
This band will be considered as the reference when registering the other bands as well as having a 
greater weight when generating the DSM. The user can then import the EO data by pressing the 
“Next…” button. 

6.1.3 Step 3 – Camera Parameters 

Camera parameters for all cameras of the project must be specified. The user can import a legacy 
SimActive camera file. Alternatively, the software can detect the values automatically, including the 
focal length and pixel size. “Digital – Polynomial” is the suggested type for non-metric cameras 
similar to those normally used on UAVs. More information on different camera calibration types can 
be found in section 16.1. If the user is working with scanned films, the fiducial detection tool will be 
shown (please refer to section 11.4 for further details). 
 

Although parameters can vary from one camera to the other, only one calibration 
type is supported for a given project.  For scanned films, if the dimensions of 
images in pixels vary, then the smallest width and height values observed should 
be specified.  Note that these minimum width and height values may come from 
two different images. 

6.1.4 Step 4 – Project Parameters 

In this step, the user defines the project location by clicking on the “…” button. There is the option 
to specify a projection, however, it cannot be different than the one selected for the images in Step 
1.  
 
The other project parameters are optional. The “DEM” option allows the user to specify (e.g. SRTM) 
a reference DEM. 
 
With the “GCP File” option, the user can specify a file containing GCP and check point information. 
The file can be an existing one or it can be created by importing data from a text file (please refer to 
section 11.5 for further details). 
 
The “Reference Orthos” option lets the user browse and select a folder containing the reference 
orthos. 
 

Both GCPs and reference orthos can be specified during project creation. However, 
when performing bundle adjustment, the user will need to select a single ground 
reference. 
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6.2 Satellite 

6.2.1 Step 1 - Image Selection 

The metadata of a satellite image is stored in its corresponding RPC file. This file comes in several 
formats, all of which are supported by Corrleator3D™. When creating a project, the user must 
specify the input RPC files of the images to be processed. Correlator3D™ automatically parses these 
files to recover the satellite parameters. For large satellite images, the images may be tiled and 
referenced by a TIL file. This TIL file will be required as an input. Only one (1) RPC file is needed per 
TIL file. The project creation wizard will automatically suggest an image file when an RPC file is 
selected first.  
 
The user has the ability to remove all selected images using the “Clear” button, choosing a new set 
of images instead. Specific images can be removed from the dataset using the “X” button on the 
right of the list of selected images. 

6.2.2 Step 2 - Image Pairing 

In order to generate a DSM using overlapping satellite images, the user must specify image pairs. 
Each pair will be used to generate a corresponding DSM, with the results merged at the end of the 
process.  
 
To construct a pair, select each of the images to be paired using the drop-down menu, and click on 
“Add”. A star (*) before the name of the image in the drop-down menu indicates that the image has 
not been used in any pair thus far.  
 
This step can be skipped if no DSM is required or if there is only one satellite image in the project. 

6.2.3 Step 3 – Project Parameters 

In this step, the user defines the project location by clicking on the “…” button. It is mandatory to 
specify a projection. The projection can be specified by selecting an existing DEM with a valid 
projection in it. 
 
The other project parameters are optional. The “DEM” option allows the user to specify (e.g. SRTM) 
a reference DEM. 
 
With the “GCP File” option, the user can specify a file containing GCP and check point information. 
The file can be an existing one or it can be created by importing data from a text file (please refer to 
section 11.5 for further details). 
 
The “Reference Orthos” option lets the user browse and select a folder containing the reference 
orthos. 
 

Both GCPs and reference orthos can be specified during project creation. When 
performing bundle adjustment, the user will need to choose which ground reference to 
use as they cannot be used simultaneously.  
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6.3 ADS 

6.3.1 Step 1 - Image Selection 

The metadata of an ADS image is stored in a standard SOCET SET support file. This support file is 
an ASCII file that uses keywords. When creating a project, the user must specify the support files of 
the images to be processed. Correlator3D™ automatically parses these files to recover the names 
of the images, the camera calibration files, and the exterior orientation data. Therefore, the user 
must make sure that all file names and paths specified in the support file are valid. 
 

In the ADS support files, paths containing spaces are not valid. 

 

Correlator3D™ only processes level 1 (L1) imagery for ADS sensors. 

6.3.2 Image Pairing 

In order to generate a DSM using ADS imagery, the user must specify image pairs. Each pair will be 
used to generate a corresponding DSM, with the results merged at the end of the process.  
 
To construct a pair, select each of the images to be paired using the drop-down menu, and click on 
“Add”. A star (*) before the name of the image in the drop-down menu indicates that the image has 
not been used in any pair thus far. This step can be skipped if no DSM is required. 
 

Better results in ADS mode will be achieved if the angle between the sensors is small (i.e. 
forward-nadir or nadir-backward). Using the pair forward-backward is likely to generate 
noisy or erroneous results due to occlusions (objects visible in one image might not be 
visible in the other). 

6.3.3 Project Parameters 

In this step, the user defines the project location by clicking on the “...” button. It is mandatory to 
specify a projection for an ADS project. The projection can be specified by selecting a DEM with a 
valid projection; it must correspond to the one specified in the support files. 
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7 DATA GENERATION 
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7.1 Aerial Triangulation  

Correlator3D™ includes an aerial triangulation (AT) module for UAV/medium/large format sensors 
and satellite sensors, which automatically improves exterior orientation values and camera 
calibration parameters from the image data.  It is therefore recommended to perform this process 
on every project to ensure the quality of the geospatial products generated from the imagery. The 
software requires as a minimum overlapping aerial images, coarse GPS measurements, and basic 
camera parameters. 
 
It is worthwhile to spend time on the AT step, as it will help save significant processing time on 
subsequent steps.  
 
To enter this mode, the user must select “Aerial Triangulation” in the “Module” menu. Aerial 
triangulation should be performed in the following order: 
 

1. Flight Line Editing (if required) 
2. Tie Point Extraction 
3. GCP Creation (if required) 
4. Tie Point Editing (if required) 
5. Bundle Adjustment 
6. Quality Assessment 
7. Image List Filtering (if required) 

7.1.1 Fight Line Editing 

Projects sometimes include images that should not be considered during processing in order 
to obtain better results. For example, images taken during takeoff or landing, or when 
changing flight direction should be removed at the beginning of the project. This can be 

done using the Flight Line Editing mode. 
 
In this mode, the user can first select individual images in the main view (or multiple 
images using the selection tool) and delete/undelete them from the project. Note 

that deleting images will not delete the images from the disk, but only remove them from the project. 
The same operations can also be performed from the project tree. For example, a complete flight 
line can be selected and deleted using the corresponding contextual button. 

 
The configuration of the flight lines can also be modified. The user can use the Connect/Cut 
tool to merge two flight lines together or cut one into two halves. This is particularly useful 

in the context where DSM tiles are generated on a per-image-pair basis and that a tile cannot be 
generated using two images from two different flight lines. To use this tool, the user simply needs 
to select a first image, and drag the cursor to the next image. If the images are already part of the 
same flight line, this one will be cut. If not, the two flight lines will be merged. Again, the same 
operations can be performed from the project tree by selecting two flight lines and using the 
corresponding contextual button. 
 

Another strategy is to use the Automatic Flight Line Calculation tool. In this case, 
Correlator3D™ will compute the flight lines from scratch, based on flight direction and 

endlap. Note that any previous flight line modification will be overwritten. 
 
When exiting the Flight Line Editing mode, the software will add a new step to the AT List of the 
project tree. If other modifications are applied afterward to the flight lines, the list will grow 
displaying all iterations. This allows flexibility to back track in case of an undesirable iteration. 
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Specifically, the last iteration may be undone or the user may choose to come back to results of a 
specific iteration. Note that if a bundle adjustment was performed, a new quality report will be 
automatically generated to reflect the new changes. 
 

7.1.2 Tie Point Extraction 

 
The next step is to extract tie points, which is performed automatically. A tie point is an 
image feature that is visible in two or more images. Correlator3D™ offers two types of tie 

point extraction: standard and exhaustive. The standard extraction type is suitable for most projects, 
while the exhaustive type is better fitted for challenging datasets with suboptimal inputs.  
 

Exhaustive tie point extraction is usually slower than standard tie point extraction. It is 
suggested to use the exhaustive type only when the standard one does not generate 
optimal results (e.g. several images that are not connected to others). 

 
If reference orthos are present, the tie point extraction process will also extract points in those 
images, even if their ground sampling distance is different. Note that these observations will be used 
during bundle adjustment only if the Ground Reference option is set to “Reference Orthos”. 
 

When processing projects with unregistered bands, the band registration process will be 
performed automatically during tie point extraction. 

 

Compared to bundle adjustment, the tie point extraction process is the most time 
consuming. If the user needs to perform numerous bundle adjustments on the 
same project, then tie points do not need to be recalculated each time. 

7.1.3 GCP Creation 

Next, the user must decide whether to use ground control points (GCP).  Although not required for 
relative accuracy, ground control points are necessary for absolute accuracy. The quality of the 
ground control points will have a strong impact on the results.  Ground control points have two 
benefits. First, they ensure that there is no global spatial offset (i.e. xyz translation) in the refined 
values. Second, they provide another means to validate the residual error of the refined values.  
 
The user can also create check points. These are special GCPs that will not be considered during 
bundle adjustment, but for which statistics and reports will be generated. Check points are used to 
assess the quality of the bundle adjustment using an independent data set. 
 
The GCP Editing tool helps the user locate GCPs in the images by selecting the best image 
candidates, and estimating where the GCPs should fall in those images. Correlator3D™ relies on the 
exterior orientation parameters and camera calibration data located in the IEO file. Upon entering 
the GCP Editing tool, the software will verify the average residual error and suggest the user to 
perform an estimation of IEO parameters if this error is too large. This will add an “Estimate” AT step 
to the project tree. When GCP creation is completed and bundle adjustment is performed, the 
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“Estimate” step will be automatically removed. Therefore, the “Estimate” step has no impact on the 
bundle adjustment process. The GCP Editing tool is described in Section 11.6. 

7.1.4 Tie Point Editing 

After the initial automatic tie point extraction step has been performed, the software will display 
links created between images. Hovering the mouse over any link displays the number of tie points 
present between those images.  
 
The user can right-click on any link to visually inspect or edit the tie points between two images, 
ensuring features match in both images.  They can also right-click on the image position to display 
the image itself, with all its feature points displayed as an overlay. 

 
Under some circumstances, it may not be possible to automatically extract tie points 
between some images. This is more likely to occur when the overlap is too low or the quality 

of images is not sufficient. The user can then manually add tie points to the project. A link can be 
added between two images by clicking on the corresponding button, by clicking and holding the left 
button on the first image and by dragging the link to the second image. The tie point editing dialog 
will appear with the two corresponding images. The user can zoom in using the mouse wheel, and 
pan by clicking and dragging with the center button (wheel).  
 

 
Figure 12:  Tie points between two images. 

 
 
At this point, the objective is to add as many tie points as possible. To do so, the user must left-click 
on one feature in one image, and drag it to the corresponding feature in the second image. The 
software will then automatically try to refine the match, and will display the Tie Point Editing 
window. In the window, the user can either validate or refine the position of the feature in each 
image. 
 
A tie point is more beneficial when the feature is identified in multiple images. Due to this, user 
should always consider using such features, distinguished as colored stars in the images. If the user 
clicks on one of these stars, then drags to the corresponding feature in the other image, the software 
will display the Tie Point Editing window. Multiple images containing the feature will be displayed 
in the ribbon. The new observation for the tie point will be identified with its name in blue. 
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When the ribbon is dragged completely to the left (therefore showing the rightmost part of 
the ribbon) a special “+” button is visible. Clicking this button will also add new image 

candidates to the ribbon. 
 
As the user enters more tie points, the software will adjust the relative orientation of the two images 
to facilitate the task. Also, when moving the cursor in one of the two images, the software will 
provide a predictor (shown as a multicolored circle) in the other image to give a hint of where the 
feature should approximately appear. This helps facilitate the process. 
 

At all times, the user can select a tie point to edit by either right-clicking on it, or using the 
corresponding button. 
 
The user can also select a tie point to delete it using the corresponding button. 
 

There is no specific rule on how many tie points should be added between two images, although 5 
or 6 is a good approximate. 
 
Note also that the goal is not necessarily insuring that there is a link between every corresponding 
image. For example, adding a link between a pair of images can tie two flight lines together, but it is 
not necessary to link each adjacent images in the flight lines. Instead, the links can be added on 
image pairs that are well dispersed (e.g. one image pair in the beginning, middle, and end of the flight 
lines). This can save the user time, while ensuring that the overall project is connected.  

7.1.5 Bundle Adjustment 

Bundle adjustment derives adjusted exterior orientation and camera data. Correlator3D™ can be 
used to perform a boresight calibration or a full AT adjustment. In the boresight calibration process, 
the software computes the error component that is common to all exterior orientation estimates. 
This corresponds to the relative position/orientation of the camera to the GPS/IMU unit. If a full AT 
adjustment is selected, then the software still automatically performs a boresight calibration 
beforehand but also computes a unique correction for each individual image. 
 
The software can also be used to perform a camera calibration in parallel to the EO adjustment. The 
software adjusts camera parameters based on the camera type used. These values may include focal 
length, principal point, LUT values, as well as radial and decentering distortion parameters. Various 
camera models are supported and described in Appendix A. 
 
When available, the user can use either ground control points or reference orthos to ensure that 
there is no global spatial offset (i.e. XYZ translation) in the refined values. 
 
When using ground control points, Correlator3D™ takes into account user error when identifying 
the GCP location in the images and also accounts for possible error in the XYZ coordinates.  In the 
bundle adjustment settings, the user may specify uncertainty values for the GCP. The "Pixel Radius" 
is the presumed error when defining the GCP locations in the image using the GCP Editing tool. For 
example, a value of 0.5 means that the user predicts having introduced an error of half a pixel when 
defining the GCP location in the image. 
 
The bundle adjustment settings let the user specify a general uncertainty for the "XY" and "Z" 
components of the GCPs. For example, an uncertainty value of 1m for the "XY" field will allow a 1m 
fluctuation to the XY values of the GCPs, whereas a value of 0m implies the user has absolute 
confidence in the GCPs. This will force the software to comply with the GCPs exactly when 
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performing an EO adjustment. This setting only applies to GCPs that do not have per-point 
uncertainty values. 
 

Per-point uncertainty values are specified using the GCP Editing tool. Different XYZ 
uncertainties can be specified for each GCP. When available, these values override the 
aforementioned general uncertainty values. 

 
When GCPs are used, final residual analysis and statistics will also be computed for the check points. 
 
If reference orthos are used, tie points detected in these images will provide horizontal (XY) 
anchoring to the project. If a DEM is currently loaded in the user interface, it will provide vertical (Z) 
anchoring.  While optional, the use of a reference DEM is recommended. 
 

Bundle adjustment can be run in two (2) modes. These are called "Constrained" and 
"Unconstrained" and apply to the camera calibration and EO adjustment settings. The EO 

adjustment setting also allows for a boresight adjustment only or for RTK/PPK assisted systems. 
The unconstrained mode performs all necessary parameter allocations for the user. It is designed to 
provide the fastest AT solution. The constrained mode requires specification of the bundle block 
settings, providing more control over the project. 
 
In the constrained mode, the user can lock one or more parameters for bundle adjustment.  These 
locked parameters can come either from the EO values and/or the camera values. For example, if 
the GPS and camera data are known to be accurate, the user may choose to lock them and only 
process the IMU portion for bundle adjustment. This would force the software to perform bundle 
adjustment only on the IMU portion of the EO values.  
 
In the constrained mode, the user is also required to define a search space for the easting (x), 
northing (y), elevation (z), omega, phi and kappa values. The search space defines the assumed 
uncertainty regarding the accuracy of the input data. For example, specifying an uncertainty of 5m 
for easting and an uncertainty of 2° for omega, restricts the software to adjust the easting and 
omega parameters from their current positions as defined by the input to a maximum of 5m and 2° 
off respectively, in the output.  
 
Note, in a full AT adjustment, the uncertainty value bounds only the full AT portion of the 
adjustment, meaning only the unique correction for each image will be bound by the uncertainty 
value. The boresight portion of the adjustment, which is automatically performed during any full AT 
adjustment, will not be bound at all. For example, if a 5m value in X was chosen as the uncertainty 
for a full AT adjustment, then as a first step, a common boresight correction of any appropriate 
magnitude (as determined by the software) will be applied to all images followed by a unique 
correction to each individual image of up to 5m in X. The user may change this behavior by 
unchecking the "Perform Boresight Calibration" option. With this option unchecked, the software 
will skip the boresight calibration process, making sure the uncertainty range is respected during the 
adjustment. 
 
The "RTK/PPK Assisted" option should only be used when the GPS data are known to be accurate. 
In that case, the software will only adjust the orientation parameters. 
 

The search space must be appropriately large to compensate for the EO errors. 
Large average residuals may imply that the search space was too small and that 
results are not optimal.   
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In the case of satellite sensors, the AT process will calculate corrections on RPC values to improve 
the accuracy of the georeference. The software requires overlapping satellite images and RPC data.  
GCPs may also be used to ensure absolute accuracy.  The EO refinement process will automatically 
adjust the RPC values and output the RMS pixel error. Note that if the project contains only one 
image, GCPs will be required to perform AT. 
 
For satellite projects, another type of EO adjustment called “Image Offset Correction” is available. 
Using this mode, the software will minimize for a 2D translation in each image frame. This type of 
adjustment is particularly useful when GCPs are not available or when the solution must be 
constrained even more. 
 
Finally, an option to remove images having a tie point residual error higher than the specified 
threshold is provided. This option is equivalent to the Image Filtering functionality described in 
section 7.1.7 except that it is performed through the bundle adjustment process. Selecting 
“Automatic” will make the software to calculate the average residual error for all images, and use a 
threshold corresponding to five times this value. 

7.1.6 Quality Assessment 

Once the bundle adjustment has been performed, the user is presented with the overall tie point 
residual error expressed as colored circles centered on each image. There are four different colors: 
 

­ Green: when the residual error is less than 0.75 pixel 
­ Yellow: when the residual error is between 0.75 and 1.5 pixel 
­ Red: when the residual error is larger than 1.5 pixel 
­ Blue:  when it was not possible to correct the position/orientation of the image (e.g. no tie 

point) 
 
Note that it is normal for the residual errors to be red in the initial step. It simply means that bundle 
adjustment is necessary to bring the values down to the green range. Tie points, ground control 
points and check points, when available, are also displayed using the same color coding. By hovering 
the mouse over a point or an image, the user can see the associated residual error in the right hand 
side of the status bar. 
 
At any time during AT, the user can switch between the color-coded circles and the kappa arrows 
by selecting the corresponding option in the “View” menu. The “IEO Display Style” option applies to 
images while the “GCP Display Style” option applies to GCPs. For GCPs, a third display style is also 
available: Spatial Residuals. 
 
The spatial residual is the difference between the specified coordinates of the GCP and the 
theoretical coordinates that are triangulated using the current IEO data. When the “Spatial 
Residuals” display style is selected, each GCP and check point is represented as a set of two arrows. 
The red arrow shows the vertical residual error. A red arrow pointing up indicates that the specified 
GCP altitude is higher than what is triangulated from the IEO data. The blue arrow shows the planar 
residual error. A blue arrow pointing north-east indicates that the specified GCP coordinates are 
north-east of what is triangulated from the IEO data. 
 
In the software interface, an AT List is displayed on the left hand side detailing the AT steps that 
have been performed. As more bundle adjustments are performed, the list grows displaying all 
iterations. This allows flexibility to back track in case of an undesirable iteration. Specifically, the last 
bundle adjustment operation may be undone or the user may choose to come back to results of a 
specific iteration.  
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Figure 13:  Bundle adjustment results. 

 
To provide the user with feedback, detailed aerial triangulation reports are generated outlining the 
statistics on all operations performed. The user has access to a general summary, or more detailed 
reports, such as boresight corrections, image and camera calibration adjustments and tie point, 
image and GCP residuals. At the end of any AT process, the software automatically displays a PDF 
report summarizing the statistics as well as the adjustment performed. For convenience, a link to 
the folder containing more detailed AT reports is also provided at the bottom left corner.  
 
The PDF report can also be accessed from the project tree using the contextual button for a specific 
bundle adjustment step. 

7.1.7 Image Filtering 

Before continuing with the rest of the photogrammetric workflow, the user should ensure 
that incorrect images are removed from the project. This will avoid having noise or other 
artifacts in their results. Therefore, the option to perform “Image Filtering” on the right-hand 

side is available. This tool creates a new AT step in which images having a tie point residual error 
higher than the specified threshold will be removed. The user can see the images being filtered in 
real-time as the threshold value is modified. Note that this operation can also be done automatically 
through bundle adjustment using the corresponding setting. 

7.1.8 Coarse DEM Extraction 

Once all iterations have been performed and the user is satisfied with the results, the 
updated project can be saved. At this point, the user can create a coarse DEM with the 

corresponding button. This coarse DEM can be useful if the user wants to assess the quality of the 
AT. For example, images could be orthorectified using this DEM to make sure that their positions 
are correct. 
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7.2 DSM Generation 

One of Correlator3D™’s core capabilities is the generation of Digital Surface Models (DSM) from 
imagery. This process requires overlapping images and associated GPS/IMU data. The user specifies 
the desired output horizontal resolution, or allows the software to compute an optimal value based 
on the input dataset. This computation considers various project parameters (e.g., image resolution, 
altitude, focal length) and aims to balance processing time and output quality. Alternatively, users 
can request a maximal resolution for finer results or a coarse resolution to speed up processing. 
 
Once the horizontal resolution is defined, the user selects a vertical accuracy using the 
corresponding slider. Lower values improve processing speed, while higher accuracies enhance 
surface detail at the cost of longer processing times. 

DSM generation is performed pair-by-pair, following the order of images in each flight line. 
Processing time scales with the number of images. For large projects, distributed processing can be 
used. The resulting DSM represents all surface elements, including terrain, vegetation, and man-
made structures. Water bodies, due to their varying appearance across images, may result in noisy 
or unreliable elevation values. 
 
A 3D constraint file can optionally be used to guide the DSM generation. This file may contain 3D 
points, lines, or polygons. When applied, constraints can help resolve elevation ambiguities—such 
as occlusions—and enforce specific elevation values in the output DSM. However, if the constraint 
data is inconsistent with the imagery or coordinate system, visual artifacts may appear. 
 
By enabling the Generate Point Cloud option, a point cloud can be computed in parallel with the 
DSM. In this mode, the software enhances the 3D reconstruction by combining multiple image pairs 
and analyzing adjacent image overlaps. Users must specify the maximum number of observations, 
which defines how many images a feature can be observed in during triangulation. A higher value 
may increase point accuracy but will result in longer processing times. 
 
Each point in the point cloud is classified based on the number of observations it is derived from, up 
to the defined maximum. This information can be used with the Point Cloud Filtering tool (see 
Section 11.13) to isolate or exclude points based on reliability criteria. Optionally, the point cloud 
can also be colorized using the original imagery. 
 

When a point cloud is generated from frame-based imagery, the resulting DSM is also 
optimized for true orthophoto generation. This produces slightly different surface 
geometry than DSMs generated without a point cloud, as visibility and occlusion are 
handled with greater precision. 

 
The following steps must be followed to perform DSM generation: 
 

1. Select “DSM generation…” in the “Processes” menu. 
2. If a 3D constraint must be used, turn on “3D Constraint”. Note that the constraint file must 

first be added from the project tree. The constraint will be displayed in the main window 
overlaid on the DEM. 

3. Specify the desired resolution.  Press the “Optimal”, “Maximal” of the “Coarse” button to 
let the program calculate an optimal, maximal or coarse value.  Once a resolution is 
specified, select a vertical accuracy from the corresponding slider bar. 

4. If a point cloud is required, turn on “Generate Point Cloud”. Specify the maximum number 
of observations and check “Colorize Point Cloud” if a colorized point cloud is required. 
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5. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 
of processing.  

6. Save the generated DSM by selecting “Save DEM As…” using the contextual button in the 
project tree. If a point cloud was generated, save it by selecting “Save Point Cloud as…” 
using the contextual button in the project tree.  
 

 
Figure 14: DSM generation dialog. 
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7.3 DTM Extraction 

Correlator3D™ features a module to extract a digital terrain model (DTM) from a digital surface 
model (DSM).  Such models are particularly useful for generating orthophotos, as they avoid visual 
artifacts (e.g. along building edges) caused by using DSMs.  The software analyses the DSM and 
automatically removes structures lying on the ground. 
 
In addition to the input DSM, an optional constraint file can be provided to Correlator3D™. This file 
can contain points, lines or polygons with elevation (3D) data. It will force the output DTM to have 
the provided elevation values at the location of the constraining elements. Alternatively, the user 
has the option to provide an exclusion zone. In such a case, the software will extract the DTM for 
all areas minus that of the exclusion zone. 
 

If a constraint is provided, Correlator3D™ will force the output values in the DTM 
to be consistent with the provided constraint. However, if the constraint is not 
consistent with the rest of the dataset, it may lead to visual artifacts in the DTM. 
If such a situation appears, the user should make sure that the input DEM and 3D 
constraint are in the same coordinate system (e.g. same datum) and that all input 
data are valid (e.g. camera calibration or exterior orientation parameters). 

 
The user can also output into a DEM the features that were removed from the DSM.  Note that only 
the DSM features will appear in that DEM.  All other elevation values will be set as undefined. 
 
To create a DTM, follow these steps: 
 

1. Select the DSM you wish to use for DTM extraction from the project tree. 
2. Select “DTM extraction…” in the “Modules” menu. 
3. If a constraint is used: 

a. Turn on “Constraint”. Note that the constraint file must first be added from the 
project tree. 

b. Specify the type. Either "Elevation" or "Exclusion Zone". 
c. Choose the file containing the constraint using the corresponding drop-down 

menu. The constraint will be displayed in the main window overlaid on the DEM. 
4. If the DSM features are required: 

a. Turn on “Output DSM Features”. 
b. Specify the output DEM file using the corresponding drop-down menu. 

5. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 
of processing.  Once the process is done, the DTM will appear in the main window. 

6. Save the generated DTM by selecting “Save DEM As…” using the contextual button in the 
project tree.   

 

 
Figure 15:  DTM extraction dialog. 
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7.4 DEM Editing 

While the DSM/DTM generation modules produce highly accurate results, the user may still desire 
to alter results according to their specific requirements. The Correlator3D™ DEM Editing module 
features ten (10) easy to use, yet powerful editing tools: 
 

– Crop an area 
– Delete an area 
– Force the elevation to a user-specified value 
– Offset the elevation by a user-specified value 
– Apply a median or mean filter of user-specified size 
– “Delete and fill” i.e. delete an area and analyze neighboring areas to fill the deleted 

region. 
– “Topological Fill” i.e. delete and fill an area while preserving the topology of the 

neighboring terrain. 
– DTM Extraction for a user specified area 
– Touch Up small areas  
– Paste an external DEM onto the existing DEM 

 
The aforementioned tools process a user-specified polygonal selection. The time required to 
perform the operations depends on the operation type and the size / complexity of the selection.  
The user can also display orthorectified images, a mosaic or any other type of reference data as an 
overlay to the DEM using the project tree.  This can facilitate the selection of features like water 
bodies. 
 
To edit a DEM with a user-defined selection the following steps must be performed: 
 

1. Enter the DEM editing module, by selecting “DEM Editing…” in the “Edit” menu. 
The editing toolbar will appear at the right of the window. 

2. Create a selection. 
3. Select an operation to perform in the Edit menu or the DEM Editing toolbar. 
4. Repeat step 2 and 3, as required 
5. Save the edited DEM by selecting “Save DEM As…” using the contextual button in 

the project tree. 
 
There are three modes of selection that are mutually exclusive: 
 

– Standard selection 
– Append a selection 
– Touch up 

7.4.1 Standard Selection 

The standard selection is the most common way of selecting an area for editing. It is used 
when several operations need to be performed sequentially on several locations. A new 

selection can be created at any time by clicking on the left mouse button. Doing so automatically 
deselects the previous selection and starts a new one. Additional left-clicks are necessary to make 
the selection.  To close the selection, the user must click in the vicinity of the initial point or simply 
right-click. 
 

A rectangular selection can also be created in a similar manner. The user simply needs to 
drag the selection onto the DEM. 
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During a selection, pan operations are supported using the middle (wheel) mouse button.  Placing 
the cursor at the edge of the display area automatically pans the DEM.  
 
 

Note that zoom operations are not permitted during a selection. 

 

Correlator3D™ supports single non-self-intersecting polygonal selections. As such, 
Correlator3D™ will refuse to add a point to or close the selection if it makes the polygon 
to self-intersect. 

 
When the selection is finalized, a contextual toolbar is displayed on the top left corner of the main 
view. With this toolbar, the user has the option to edit the selection with different tools before 
doing an operation on the region.  

 
The first one, the hand tool, is used to move, add, or delete selection points. A point can be 
moved by clicking on its vicinity with the left button of the mouse and dragging it at a new 

location. Conversely, it can be removed by clicking on the right button. New points can be added by 
clicking on the right button of the mouse anywhere on the selection. 
 

Depending on the scale factor, Correlator3D™ will adjust automatically the level of 
details of the selection. Therefore, if the user zooms in the selection, additional selection 
points will be shown. 

 
The second tool, the scissors tool, is used to remove a series of selection points and replacing 
them with new ones. A first point must be selected with clicking on the left button of the 

mouse, and then a second one to determine the series of points to be removed. New points can 
then be added to follow a new path, starting from the last point to the first one. 
 

Note that elevation values for each vertex of the polygon can also be manually set. Use this 
function to select any vertex and change the elevation value. 

 
The last operation on a selection can always be undone by pressing the corresponding 
button in the mosaic editing toolbar or using the keyboard shortcut “Ctrl-Z.” 

 
Correlator3D™ also offers automatic tools to modify a selection. If instead of a polygonal 
selection the user wishes to select a feature, the Feature Selection option should be used. 

This option will snap automatically to the boundary of the feature contained within the original 
selection.  The user has then the option to edit the selection by moving existing points or creating 
new ones. 
 

The user can also snap the selection based on elevation values. This is particularly useful to 
select undesired spikes or other features to be removed quickly. When clicking on this 

button, a dialog will be displayed to select the criteria to be used to snap the selection. For example, 
the user could choose to select everything above a certain elevation. 
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Once the selection is completed, the user can either select the DEM operation to perform, 
or save the selection before by clicking on the “Save Selection” button from the contextual 

toolbar, or by using the “Enter” keyboard shortcut. 
 

A selection can also be cleared by clicking on the “Delete Selection” button from the 
contextual toolbar or by using the “Escape” keyboard shortcut. 
 
Finally, if the user wants to edit the selection after saving it, clicking on the selection will 
bring back the contextual toolbar, and editing will be possible. Clicking the “Discard 

Changes” button will bring back the original selection. 

7.4.2 Save a Selection to Disk 

Once a selection has been created, the user can save it by clicking the “Save Selection” 
button from the DEM Editing toolbar. The new feature file will be added automatically to 

the project tree, allowing the user to save the selection to disk (by using the corresponding 
contextual button next to it). This can be particularly useful if the same selection has to be used with 
several DEMs. It can also be used to define exclusion zones or other types of constraint that can be 
used during other processes like the DTM Extraction. Note that this step is also required if multiple 
selections need to be defined. 

7.4.3 Edit Feature File 

Once a feature file has been created, the user can toggle the “Edit Feature File” mode to 
modify or append other selections to the file. This can be particularly useful if the same 

operation has to be applied simultaneously on several locations. 
 
This mode provides the exact same functionality as the Standard Selection, meaning that a 
contextual toolbar will be displayed for each new selection that is being appended. The user can 
click on the “Save Selection” button from the contextual toolbar to add this new selection to the 
file. Note that, just like in the “Standard Selection” mode, it is always possible to edit one of the 
selections by clicking on it. 

7.4.4 Touch Up 

The Touch Up tool works in a similar manner than the Delete and Fill tool. Instead of 
requiring a manual polygonal selection, a small fixed-size square selection is automatically 

performed around the location clicked by the user. The tool requires less user interaction and the 
internal processing is optimized for higher performances. Thus, it is a very fast tool to correct small 
areas. 

7.4.5 Crop 

Correlator3D™ features a polygonal crop tool. Once a polygonal selection is made, the Crop 
tool will discard any elevation values outside the selection. The DEM will also be resized to 

fit the size of the bounding box of the selection. To use the Crop tool, select “Crop” from the “Edit” 
menu. 
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7.4.6 Delete 

The Delete tool discards all elevation values inside the selection, leaving any other value 
intact. To use the Delete tool, select “Delete” from the “Edit” menu. 
 

7.4.7 Set Elevation 

The Set and Offset Elevation tools are accessible from the same dialog. 
 

 
Figure 16: Set and offset elevation dialog. 

 
The Set Elevation operation sets the selected DEM cells to the specified elevation, while the Offset 
Elevation operation offsets the selected DEM cells by the specified elevation. The elevation can be 
a positive or negative value and is specified in the DEM units (meters or feet). 

 
To use the Set Elevation or the Offset Elevation tool, select “Set Elevation…” in the “Edit” 
menu. 

7.4.8 Filter 

The filter tool applies a mean or a median filter to the selected DEM cells. Cells outside the selection 
and cells located on the border will be used to compute filtered elevation values. However, these 
cells will remain unaffected by the process. Settings can be adjusted using a dialog. 

 

 
Figure 17: Filter dialog. 

 
 
The following is a description of the required settings: 
 
Filter Type: Decides between mean and median filters. 
Filter Size: Diameter of the filter, specified in DEM units (meters or feet). The specified value must 

be an odd multiple of the DEM resolution. 
 
To use the Filter tool, select “Filter…” in the “Edit” menu. 
 



Data Generation | 55 

7.4.9 Delete and Fill 

Delete and Fill is probably the most useful and powerful editing tool provided by 
Correlator3D™. With a single click, all the selected DEM cells are deleted and replaced by 
new elevation values obtained from an analysis and interpolation of the area surrounding 

the selection. It requires no parameters to be specified and provides excellent results in most 
situations. To use the Delete and Fill tool, select “Delete and Fill” from the “Edit” menu. 

7.4.10 Topological Fill 

The Topological Fill tool provides similar functionality to the Delete and Fill tool, except that 
it analyzes the topology of the neighboring terrain to better interpolate the area. For 

example, it can be used to remove a feature located on a slope. To use the Topological Fill tool, 
select “Topological Fill” from the “Edit” menu. 

7.4.11 DTM Extraction 

The DTM Extraction tool extracts the DTM for the selected DEM cells. It uses the same 
algorithms than the DTM extraction process and settings can be adjusted using a similar 
dialog. Please refer to Section 7.3 for further details. To use the DTM Extraction tool, select 

“DTM Extraction” from the “Edit” menu. 
 

 
Figure 18: DTM extraction dialog. 

7.4.12 Paste DEM 

The Paste DEM tool replaces regions of the current DEM with a provided DEM. The user 
can adjust the height tolerance parameter that defines the difference in height between the 

two DEMs for which a smooth transition will be calculated. Hence, elevation values showing a 
difference smaller than this value will be averaged in the final DEM. To use the Paste DEM tool, 
select “Paste DEM” from the “Edit” menu. 
 

The Paste DEM tool will not consider any current selection as the input DEM will be 
pasted entirely. 
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Figure 19: Paste DEM dialog. 

7.4.13 DEM History (Undo/Redo) 

The history of each modification made to the DEM is automatically saved. This history is displayed 
below the project tree as a list of all operations that were performed to the DEM. Clicking on one 
of the operations will undo all subsequent operations. To better guide the user on what operations 
should be undone, Correlator3D™ provides the following visual feedback: hovering the cursor above 
any item of this list will display all the modified regions so far as an overlay to the DEM. Regions 
shaded in blue with a number in it correspond to the regions that will not be affected by the “Undo” 
operation if the user clicks on this item. Regions shaded in red correspond to regions for which the 
modifications will be canceled. Note that it is always possible to redo the operations if no operation 
is made after the undo. 
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7.5 Orthorectification 

Correlator3D™ can generate orthorectified images.  The user can specify the desired output 
resolution, or simply request the software to calculate the optimal or coarse value for better 
processing times.  This feature automatically determines the ground sampling distance (GSD) of the 
input imagery. 
 
Correlator3D™ can generate true orthos if a DSM and/or a constraint file is used.  In such a case, 
the orthorectification process will correct for the distortion of buildings and other 3D structures, 
resulting in a true ortho.  Occluded areas which have no image content, e.g. building shadows, will 
be set to black in the final orthorectified image. Note that if a constraint file is inputted, it must 
contain polygons with elevation (3D) data defining the structures. 
 
For frame-based sensors, the user can also specify the overlap of the resulting orthophotos. By 
default, the software will suggest the maximal overlap, i.e. the actual overlap between images. The 
user can also select the optimal overlap, which corresponds to 30%. 
 

Choosing a smaller overlap will result in a faster orthorectification, smaller orthophotos 
on disk and ultimately faster mosaic creation.  Note however that reducing the overlap 
between orthophotos will also reduce the area where a mosaic seamline can go through 
and may therefore impact results. 

 
For UAV/medium/large format sensors, the user can crop the image borders to any percentage 
value. This allows for forward and sidelap control, which may be desirable as a strategy to extract 
the most nadir image portion from the orthophoto, or to remove artifacts that are systematically 
present in all images. 
 
For multispectral cameras, the user has the option to calculate reflectance information for each 
image and add it to the resulting orthophotos. This information will be used afterwards when 
creating a mosaic from the orthophotos, and when finally exporting a reflectance map. The 
reflectance information can be calculated using calibrated data that come either from a sun sensor, 
or calibrated reflectance panels, or both. Please refer to section 11.5 for further details about 
calibrated reflectance panels. 
 
If the multispectral sensor includes a higher-resolution panchromatic band, pansharpening can be 
applied during orthophoto generation to enhance the spatial resolution of the lower-resolution 
bands. In this case, the panchromatic band is fused into the other bands and thus not included 
separately in the orthophotos. This process alters the pixel values and may affect reflectance 
accuracy. However, for index calculations based on ratios between bands (e.g., NDVI), the 
pansharpening effect cancels out, so these indices retain their integrity but do not gain in precision. 
In fact, even without pansharpening, all bands are upscaled to match the panchromatic resolution 
for orthophoto generation, so there is no net gain in resolution. 
 

The output format of the orthorectified images is by default tiled with overviews. 
This should not be changed if the user prefers using the Mosaic Editing module 
afterward to obtain the highest performance. 
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Since orthos can sometimes take significant disk space, the user has the option to store 
them as JPEG-compressed TIFFs. While this type of compression it not lossless, the 
quality of the orthos will not be significantly affected. An additional band will also be 
added to the orthos to store the validity of each pixel for mosaicing. 

 
A real-time overview of the orthophotos will be displayed during processing.  Each time an 
orthorectified image is generated, it will appear as an overlay to the currently loaded DEM. 
 
To create orthorectified images, the following operations should be performed: 
 

1. Select the DEM you wish to use for orthorectification from the project tree. 
2. Select “Orthorectification…” in the “Processes” menu. 
3. If true orthorectification is required and a DSM is loaded, turn on “DSM-based”. 
4. If a 3D constraint file is used, turn on "Constraint File". Note that the constraint file must 

first be added from the project tree. The constraint will be displayed in the main window 
overlaid on the DEM. 

5. Specify the desired output horizontal resolution or press the “Optimal” or “Coarse” button 
to let the program calculate an optimal or coarse value. 

6. In the "Settings", select "Overlap" to specify the desired output overlap percentage. Press 
the “Optimal” or the “Maximal” button to let the program calculate the optimal or maximal 
value. To crop the image width and height, select "Crop" and specify the desired 
percentages. 

7. If the camera is multispectral and reflectance information needs to be calculated, check 
“Use Calibration Panels” or “Use Sun Sensor”, or both. Enable the option “Pansharpening” 
if a panchromatic band is available and pansharpening is required. 

8. Specify the format for the orthorectified images. 
9. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing. 
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Figure 20:  Orthorectification dialog. 
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7.6 Mosaic Creation 

The mosaic creation module allows for the merging of individual orthorectified images to obtain a 
unique image covering the entire project area. The process is entirely automated. Correlator3D™ 
will select which portion of which image must be included in the final mosaic. Local intensity 
adjustments and seamline generation are performed to provide smooth and seamless transitions 
between adjacent images composing the mosaic. 
 
Before starting the mosaic operation, the user can specify how many blocks to divide the mosaic 
into at minimum. A block is a smaller section or part of the overall mosaic. The purpose of this is to 
support the generation of large mosaics but also to allow multiple users to edit different blocks 
simultaneously after the mosaic has completed. The number of blocks is therefore dependent on 
the user’s choice and project size. The software will create the blocks according to the user's 
selection, but may need to perform further block divisions as necessary. 
 
Selecting the Bound Mosaic Area option allows to generate a mosaic for only a portion of the 
project, as defined by a user created polygons stored in a tile definition file or a Shapefile. The user 
can also specify the size of the feathering zone depending on project type.  The feathering zone is 
the region along a seamline where blending will be applied to ensure a smooth transition from one 
image to the other.  For urban areas, a smaller value is recommended to avoid ghosting effects along 
smaller objects like cars.  In other areas like open fields, the value should be larger since the content 
is very similar from one image to the other. The size of the feathering zone is specified in pixels.  
Note that when editing a mosaic, a different value can be specified for each seamline. 
 
Fully automated color balancing can be applied during the mosaic creation process. This balancing 
includes: 
 

­ Brightness and contrast adjustments of each image 

­ Inter-image equalization 

­ Independent channel analysis for hue equalization 

­ Photometric constraints to maintain global information of brightness, contrast and hue 

 
Some projects may include regions where colors are very different from one image to the other (e.g. 
water bodies).  In order to avoid these regions to have too much effect on the color balancing results, 
the user can specify an exclusion zone.  This file can contain several polygons depicting the regions 
to be ignored. 
 
To profit from the most nadir portion of the orthophotos, the user can select the “Nadir 
Optimization” option. This allows improving the overall mosaic quality while increasing processing 
speed. 
 
To further improve the quality of the seamlines and make sure they wave around obstacles, the user 
can select the “Use Loaded DEM for Seamline Obstacle Avoidance” option. The process will then 
consider the currently loaded DEM (generally a DSM), in addition to all other mosaicing algorithms, 
to compute the optimal seamlines. 
 
The output of the mosaicing process consists of a single image divided in multiple blocks, themselves 
divided into multiple tiles. Files required to manually edit the mosaic seamlines and colors are 
automatically generated during mosaicing and are stored in subfolders to the mosaic folder. The 
software has therefore its own structure to store the files. Users who desire to specify their own 
mosaic tiling and format have to export the mosaic. This functionality is described in section 11.9. 
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To create a mosaic, follow these steps: 
 

1. Make sure the project includes orthos. 
2. Select "Mosaic Creation…" in the "Process" menu. 
3. If only some portions of the orthos need to mosaiced, turn on "Bound Mosaic Area" and 

specify the file using the corresponding drop-down menu. 
4. Specify the size of the feathering zone in pixels. 
5. Specify the minimum number of blocks. 
6. If color balancing is required, turn on "Color Balancing". 
7. If an exclusion zone is specified, check "Exclusion Zone File" and specify the file using the 

corresponding drop-down menu. 
8. If nadir optimization is required, turn on "Nadir Optimization". 
9. Turn on “Use DSM to Constrain Seamlines” if seamlines need to be further improved. Make 

sure the corresponding DSM is currently loaded in the user interface. 
10. Click on the "Process" button.  Real-time feedback will be provided on the overall progress 

of processing. 
 
 

 
Figure 21: Mosaic creation dialog. 
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7.7 Mosaic Editing 

The mosaic editing module allows the auto-generated mosaic to be interactively adjusted according 
to specific user requirements. It provides smooth interaction with the data and enables real-time 
updates during modifications, without needing to regenerate the entire mosaic. This design reduces 
the number of manual operations required, significantly increasing overall productivity. 
 
Correlator3D™ allows multiple users to simultaneously edit a mosaic without conflicts or data 
duplication. This capability enables multiple users to access the same mosaic, significantly reducing 
storage requirements and ensuring fast, efficient operation suited for production environments. 
 
To edit a mosaic, please follow these steps: 
 

1. Make sure the project includes a mosaic and the orthos used to generate this mosaic. 
2. Select “Mosaic Editing…” in the “Processes” menu. The mosaic and the corresponding 

blocks will then appear in the main window. 
 

Upon entering mosaic editing mode, users are presented with a view of the entire mosaic and a 
block overlay. The block overlay reveals how the mosaic is divided. This view enables users to apply 
global operations to the entire mosaic area, including exporting seamlines, exporting the mosaic, and 
manually adjusting colors. 
 
Users can also edit the auto-generated seamlines by selecting which block(s) to work on. Blocks are 
selected by clicking on them. While each mosaic block can be edited by a single user, different 
mosaic blocks can be edited simultaneously by multiple users. To facilitate multiple users' seamline 
editing capability, Correlator3D™ provides an automatic locking system. Blocks already in use 
cannot be selected and will be shaded in red to indicate they are locked by another user. If no blocks 
are in use, they will all be shaded in green to indicate they are available. 
 

Please note, while users do not need to manually select them, all blocks must be available 
(i.e. not locked) to export seamlines, export the mosaic or manually adjust colors. 

 

7.7.1 Export Seamlines 

Users can export the seamlines to an ESRI Shapefile by pressing the corresponding button 
in the toolbar. 

7.7.2 Adjusting the Colors 

Users can adjust the global colors of the mosaic using the Color Adjustment tool to enhance 
its visual appearance. This tool allows modifying the levels of the mosaic, including adjusting 

the brightness, contrast, and gamma for each individual channel or for all channels together. 
 
In the Channel drop-down list, users can select a color channel to edit. Depending on the number 
of channels in the imagery, users can choose the "Master" channel to edit the red, green, blue, and 
alpha channels together, or choose "Red," "Green," "Blue," or "Alpha" to edit the channels 
individually. Note that selecting the "Alpha" channel will also allow users to display this channel in 
the main window. For grayscale mosaics, only one channel can be selected. 
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The original histogram of the mosaic for the selected channel is displayed in blue in the dialog, while 
the new histogram to be applied is overlapping in red. A preview of the adjusted mosaic is displayed 
on the mosaic in the main window. This option can be toggled at all times in the color adjustment 
dialog. 
 
To increase the contrast of the image, users must drag the input levels sliders, which show the 
image’s brightness values. To darken the darkest values, the left slider must be dragged to the right; 
all values below this setting become zero (black). To lighten the lightest values, the right slider must 
be dragged to the left; all values above this setting become 255 (white) or 65,535 for 16-bit imagery. 
To change the value of medium grey, the gamma slider must be dragged left or right; the range for 
the gamma value is 0.1 to 10.0, with 1 being in the middle. 
 
To decrease the contrast, users must drag the output levels sliders. To lighten the darkest pixels, the 
left slider must be dragged to the right. To darken the lightest pixels, the right slider must be dragged 
to the left. 
 

 For 16-bit imagery, users can activate the "Stretch" mode in the main window. When 
the Color Adjustment dialog is displayed, activating this mode will automatically stretch 
the histogram of the Master channel, providing a quick way to adjust the colors across 
the 16-bit range. 

 
Adjustments to the mosaic on disk will not be applied until the "Process" button is clicked. Please 
note that once the process begins, it cannot be stopped, as all mosaic tiles on disk must be adjusted 
with the same parameters. 
 

Adjusting the colors on a multispectral mosaic for which reflectance information was 
calculated during orthorectification will automatically remove this information. 

 

 
Figure 22: Color adjustment dialog. 
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7.7.3 Seamline Editing Mode 

Seamline editing allows users to modify automatically generated seamlines, which are the 
boundaries where adjacent images are joined together in a mosaic. This process can be useful for 
meeting specific user requirements and improving the overall quality of the mosaic. By adjusting the 
seamlines, users can better align the images and reduce visual artifacts, resulting in a more seamless 
and visually appealing final product. 
 

 
After the blocks to be edited have been selected, press the "Seamline Editing" button to 
enter Seamline Editing Mode. 

 
Note that users can toggle back to the mosaic overview to select different blocks by pressing 
the "Block Section" button. 
 

To ensure smooth operation and to minimize memory requirements, it is recommended 
to select the fewest blocks possible when entering into seamline editing mode. 

 
When entering Seamline Editing Mode, several buttons in the main toolbar are available to visualize 
the mosaic in different ways or with different overlays. 

 
Toggling the "Mosaic Blocks" button displays the mosaic tile definition. The name of each 
tile, as well as its boundaries, will be shown as an overlay on the mosaic. If a tile overlay was 

not provided by the user, this option will display the software's internal tile definition for the blocks. 
 
The "Mosaic" button toggles between the mosaic view and the original orthos (without color 
balancing). When displaying the orthos, users will see them as a patchwork of individual 

orthorectified images. 
 
The "Seamlines" button toggles the visibility of the seamlines, allowing users to show or hide 
them for better visualization during editing. 
 
For 16-bit imagery, users can also stretch the histogram to improve brightness and contrast 
during mosaic editing. This can be enabled or disabled by toggling the "Stretch" button. Note 

that enabling this mode will not modify the colors of the mosaic on disk. 
 

7.7.3.1 Interacting with Seamlines 

Users can modify the path of a seamline using various tools, accessible by clicking on their 
corresponding buttons in the mosaic editing toolbar. When a seamline is selected with one of these 
tools, the corresponding orthos are displayed along with their contours in black. These contours 
indicate the boundaries within which the seamline can be moved, ensuring it stays within the 
intersection of the two ortho contours. 

 
The hand tool is used to move, add, or delete seamline points. To move a point, click near it 
with the left mouse button and drag it to a new location. To remove a point, click on it with 

the right mouse button. To add a new point, left-click anywhere on the seamline. Note that 
intersections of more than two seamlines can be moved but not deleted. 

 
The scissors tool is used to remove a series of seamline points and replace them with new 
ones. Select the first point by clicking with the left mouse button, then select the second 

point to define the series of points to be removed. Add new points to follow a new path, starting 



Data Generation | 65 

from the last selected point to the first. Right-click when adding the final point to complete the 
operation. 
 

Depending on the scale factor, Correlator3D™ will adjust automatically the level of 
details of the seamlines. Therefore, if users zoom in the seamlines, additional seamlines 
points will be shown. 

 

7.7.3.2 Seamline Toolbar 

 
When seamlines are edited, a contextual toolbar is displayed, offering several operations. 

 
While modifying the path of a seamline, Correlator3D™ displays in real-time what the mosaic 
will look like (without feathering and color balancing applied). A drop-down menu in the 

toolbar allows users to toggle between the original mosaic view and the orthos, helping them make 
more informed decisions about the new path of the seamline. 

 
Once users are satisfied with their seamline modifications, they must save the changes by 
pressing the corresponding button in the toolbar. This updates the mosaic by processing 

only the modified regions, applying feathering and color balancing, which eliminates the need to 
regenerate the entire mosaic and allows users to see the final result in seconds. 
 

 Multiple seamlines can be edited before saving and updating the mosaic. 

 

If necessary, modifications can be discarded by pressing the corresponding button in the 
toolbar. 
 
On larger projects, it is essential to determine which seamlines have been inspected or 
modified to avoid duplicating efforts. It is strongly recommended to use the Mark/Unmark 

functionality to keep track of progress. Using the selection tool, users can select completed 
seamlines and press the “Mark” button, changing the seamline color to black. Seamlines can be 
unmarked by toggling the same button. 
 

 When moving points of a seamline, a red region is displayed around it. This region 
corresponds to the feathering zone, where a progressive transition is made between 
images. Users should consider this region when defining the path of a seamline, as it may 
result in blurry areas in the final mosaic. For example, the feathering zone should not 
pass near an object if the object does not appear in both images. 

 
Users can also modify the size of the feathering zone for a specific seamline. Once the new 
size is set, it adjusts the size of the red region displayed around the seamline when its points 

are moved. The new size only affects the currently selected seamline, and different sizes can be 
specified for each seamline. 
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If a seamline traverses multiple blocks, only the section of the seamline within the 
currently loaded blocks will be available for editing, and modifying the point at the 
boundary of the block will not be possible. Additionally, changing the feathering size will 
not be possible unless all blocks containing the seamline are loaded, as the feathering 
size can only be adjusted for the entire seamline. Therefore, users must load all blocks 
containing a seamline to change its feathering size. 

 

7.7.3.3 Ortho Patch 

While editing seamlines is generally efficient, there are cases where using the Ortho Patch tool can 
be even more effective. For instance, when ensuring that a very large building comes from a single 
ortho, the Ortho Patch tool becomes extremely useful. 

 
To use the Ortho Patch tool, users need to select it from the toolbar. Then, with the mouse 
cursor, they should click at the center of the area where they want to create an ortho patch. 

A "Select Ortho" window will appear, listing all the orthos that intersect with the selected region. 
Users can then select each ortho from the list, which will appear as an overlay on top of the mosaic. 
A text search function is also available in the window, allowing users to quickly find a specific ortho 
if its name is already known. 
 
Once the desired ortho is selected, users can begin defining the patch area by clicking with the left 
mouse button on the overlay. This indicates to the software which part of the ortho should be used 
for the patch. To complete the selection, users must click the last point with the right mouse button. 

 
The contextual toolbar will also appear when using this tool. It contains an "Ortho" button 
that toggles the visibility of the selected ortho, facilitating the editing of the selection if 

needed. 
 
After making the necessary adjustments, users can click "Save" to update the mosaic. All seamlines 
will be adjusted accordingly, ensuring that this section of the mosaic remains editable in the future. 
 

7.7.3.4 Selection of Multiple Seamlines 

The multiple seamlines selection tool, as its name suggests, allows users to select several 
seamlines at once in order to perform operations on all of them simultaneously. Once the 

seamlines are selected, a contextual toolbar will appear, offering two possible operations. 
 

The first is the Mark/Unmark functionality to keep track of progress. Using the selection 
tool, users can select completed seamlines and press the "Mark" button, changing the 

seamline color to black. Seamlines can be unmarked by toggling the same button. 
 
The second operation allows users to modify the size of the feathering zone for all the 
selected seamlines. 
 
When the modifications are completed, users can press the "Save" button to apply the 
changes. 

 

7.7.3.5 Undo and Redo 

The undo and redo actions are essential tools when editing seamlines in Correlator3D™. Every 
modification made to one or more seamlines can always be undone, even if the changes have been 
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saved and the mosaic has been updated. This ensures that users can easily revert any unintended 
or unsatisfactory changes, providing flexibility during the editing process. 

 
The undo function allows users to step back through their recent changes, undoing each 
modification one at a time. This is particularly useful when users realize that a previous 

adjustment was more effective, or if they make an error during the editing process. The ability to 
undo actions helps maintain a smooth workflow and prevents the need to start over from scratch. 

 
Conversely, the redo function re-applies the changes that were undone. This is useful if users 
accidentally undo a change or decide that the original modification was indeed the best 

option. The redo function ensures that users can move forward and backward through their editing 
history without losing any progress. 
 
Both the undo and redo buttons are conveniently located in the mosaic editing toolbar, making them 
easily accessible during the editing process. By using these tools, users can efficiently manage their 
seamline modifications and ensure that the final mosaic meets their desired quality and accuracy. 
 
 
The following table summarizes the keyboard shortcuts that can be used when editing seamlines. 
 

Action Keyboard Shortcut 
Undo the last operation on a seamline Ctrl-Z 
Redo the last operation on a seamline Ctrl-R 
Change current editing tool (Hand <-> Scissors) Tab 
Save modifications to a seamline Enter 
Discard modifications to a seamline Esc 

Table 5:  Keyboard shortcuts for mosaic editing. 
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7.8 3D Model Generation 

Correlator3D™ can generate photorealistic 3D models. In a standard workflow, the process creates 
a mesh from a selected input, and then uses input images to apply a texture. The input used for 
model generation can be a DSM, a point cloud (such as one generated during DSM production or 
imported from lidar), or an existing 3D model available in the project tree. 

 At the top of the 3D Model Generation dialog, the user must select the input source. A 
point cloud is typically the preferred input, as it provides full 3D geometry, unlike a DSM, 
which represents a 2.5D surface. When a point cloud is selected, the resulting 3D model 
captures more realistic volume and elevation variations, especially in complex 
environments. 

If an existing 3D model is used as the input, it will act as a seed for processing: the mesh may remain 
unchanged or may be simplified based on the selected size settings. If the “Generate Texture” option 
is selected, a new texture will be computed based on the input images. 
 
An important consideration when generating a 3D model is its size. Third-party 3D viewers typically 
require that the entire model fits into GPU memory to allow for smooth visualization. Correlator3D™ 
provides a slider bar for users to define the model size. A smaller, coarser model minimizes resource 
usage but contains fewer mesh and texture details. A larger model increases GPU workload but 
delivers higher visual fidelity. The “Optimal” option selects a size that balances visual quality and 
resource usage. The range of the slider is automatically adapted to the GPU memory available on 
the processing system. 
 
Depending on the selected parameters, the “Notes” section in the dialog is updated dynamically to 
describe the process and its expected outputs. It indicates the type of input selected (DSM, point 
cloud, or 3D model), the estimated number of triangles in the resulting mesh, the number and 
resolution of texture files (if applicable), and the anticipated GPU memory usage. 
 
The following steps must be followed to perform 3D model generation: 
 

1. Select a DSM, a point cloud, or a 3D model from the project tree. 
2. Open the “3D Model Generation…” option from the “Processes” menu. 
3. If textured is required, turn on “Generate Texture”. 
4. Specify the model size using the corresponding slider bar. Press the “Optimal” to let the 

program calculate an optimal value. 
5. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing.  
6. Save the generated 3D model by selecting “Save 3D Model As…” using the contextual 

button in the project tree. 
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Figure 23: 3D Model generation dialog. 
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7.9 Gaussian Splat Generation 

The Gaussian splat generation module creates a 3D representation of a scene from imagery by using 
a large number of small, semi-transparent elements called “splats”. These elements are positioned 
and shaped in space to reproduce both the geometry and appearance of the scene when viewed 
from different angles. 
 
The process requires a colorized point cloud as input. This point cloud is used as an initial 
approximation of the scene geometry and is refined during training. A very high density is not 
required: a moderate-density point cloud is generally sufficient since the algorithm reconstructs and 
enriches the representation. Higher-density inputs can still be used and may improve fine details in 
some areas, depending on image quality and coverage. 
 
The visual quality of the resulting model is inherently linked to the viewpoints present in the input 
images. When images are primarily acquired from nadir perspectives, the generated model will be 
optimized for those viewpoints. As a result, rendering from similar angles will provide the best visual 
fidelity, while more oblique views may show reduced detail. 
 
Three quality levels are available: 
 

- Fast: prioritizes speed. Lower resolution and fewer iterations. Suitable for quick previews. 
- Balanced: compromise between speed and quality. Recommended default. 
- Precise: prioritizes quality. Higher resolution and longer processing time. 

 
Gaussian splat generation requires an NVIDIA GPU with CUDA support. The process relies heavily 
on GPU acceleration and cannot be executed without compatible hardware. 
 
When the resulting splat model exceeds practical size limits, the software automatically partitions it 
into multiple tiles. These tiles are grouped under the main model in the project tree and are handled 
transparently during visualization. 
 
The following steps must be followed to perform Gaussian splat generation: 
 

1. Select a a point cloud from the project tree. 
2. Open the “Gaussian Splat Generation…” option from the “Processes” menu. 
3. Specify the quality level using the corresponding slider bar. 
4. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing.  
5. Save the generated splat model by selecting “Save Splat Model As…” using the contextual 

button in the project tree. 
 
 

 
Figure 24: Gaussian splat generation dialog. 
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7.10 Gaussian Splat Editing 

The Gaussian splat editing module allows visualization and refinement of a splat representation. It 
provides tools to inspect the data and remove unwanted elements from the final result. 
 
Editing consists primarily of deleting splats that are not desired. Selections are performed based on 
the centers of the splats, which are highlighted when selected. 
 
Three selection modes are available: 

 
- Rectangular selection: selects splats within a defined rectangular area. 

 
- Polygonal selection: allows precise selection using a custom polygon. 

 
- Brush selection: enables interactive selection by painting directly over the splats. 

 
 

 
Once a selection is made, the corresponding splats can be deleted from the representation. 
 
An undo/redo system is available to revert or reapply modifications, allowing safe and 
iterative editing. 
 
A display option is also available to show the centers of the splats in blue. This can be useful 
in situations where the structure of the data needs to be better understood or when refining 

selections. 
 
The following steps must be followed to perform Gaussian splat editing: 
 

1. Enter the Gaussian splat editing module, by selecting “Gaussian Splat Editing…” in the “Edit” 
menu. The editing toolbar will appear at the right of the window. 

2. Choose a selection mode (rectangular, polygonal, or brush). 
3. Select the splats to remove. 
4. Delete the selected splats. 
5. Save the edited splat model by selecting “Save Splat Model” using the contextual button in 

the project tree. 
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8 AUTOMATED WORKFLOW 

The automated workflow is an automatic solution to the Correlator3D™ data production process. 
This tool is used to perform the complete Correlator3D™ workflow: 
 

­ Aerial Triangulation 
­ DSM Generation 
­ DTM Extraction 
­ Orthorectification 
­ Mosaic Creation 
­ 3D Model Generation 
­ Gaussian Splat Generation 

 
 
To start processing, the user must first select a processing profile. Five profiles are available 
corresponding to common processing needs: 
 

­ Quick Project Overview: generates all outputs at coarse resolutions. 
­ True Ortho: generates all outputs at optimal resolutions and a true orthomosaic. 
­ Classic Photogrammetric: generates all outputs at optimal resolutions and a DTM-

based orthomosaic. 
­ Fast Ortho: generates coarse DEM and an orthomosaic at an optimal resolution. 
­ 3D Model: generates a 3D model. 
­ Gaussian Splats: generates a Gaussian splat model. 

 
Each profile has its own set of parameters and options. For specific requirements, the user can 
customize the options of a profile. It is important to note that each processing step is optional. By 
simply selecting or de-selecting a checkbox, the user can perform desired actions. For example, the 
user can start the automated workflow from DTM up to mosaic by using only the appropriate toggle 
switches. 
 
When selecting the “Generate script”, the user can create a script with the chosen actions and 
parameters and skip the processing. The script is saved to a text file (Project.spt) in the project folder. 
This script can then be adapted to specific requirements, where other variables and parameters can 
be changed from the default settings. The user can then execute the script from the file menu.  
Further details can be found in section 0.  
 

8 
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Figure 25: Automated workflow dialog. 
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9 FEATURE EXTRACTION 

The feature extraction module enables the user to extract 3D features from a DSM by creating 3D 
polygons. Automatic contour detection of buildings and other features enable fast footprint 
collection. Intelligent analysis aids the user while editing features, using the 3D information in the 
DSM to automatically calculate how well planes fit the segmented polygon and providing visual 
feedback. Feedback can also be provided through real-time true orthorectification to achieve pixel 
accuracy. This semi-automatic design saves time over traditional vector extraction methods. 
 
 To extract features, the following operations should be performed: 
 

1. Select the DEM you wish to use for feature extraction from the project tree. 
2. Select “Feature Extraction…” in the “Mode” menu. 
3. Turn on the Edit/Append box to edit an existing vector file. Specify the vector file using 

the corresponding drop-down menu. The vector file must be an existing ESRI shapefile 
containing 3D information. 

4. Turn on the "Real-time True Ortho" box to enable this feature.  Specify the DTM file using 
the corresponding drop-down menu. 

5. Click on the “Process” button to start extracting 3D features. The resulting vector 
information will be saved in a new vector file once the user chooses the save option in the 
feature extraction menu. 

 
 

 
Figure 26: Feature extraction dialog. 

 

If loading an existing vector file containing building footprints, the user will need to 
select/edit each building to assign a 3D polygon. 

 

9 
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9.1 Extraction Modes 

There are four modes in which the user can interact with the DSM. These four modes are based on 
feature type which includes buildings, roads, water bodies and forests. The default mode is buildings. 
The user can switch modes by clicking on the Process menu and selecting the mode of choice.  
 

9.1.1 Building Extraction Mode 

Should the user wish to extract buildings must first ensure they are in the building extraction 
mode. A building is selected in 2 steps. First, pan and zoom to the area of interest. Second, 

make a rough selection around the building by clicking around the building perimeter. The software 
will automatically squeeze the selection around the contour of the building as shown in Figure 27. 
 

The user can go back to the original selection by selecting "Undo" in the "Edit" menu. 

 
 

 
        Figure 27: Contour around a building. 
 

The user then has the option to modify the contour according to their requirements using 
the hand tool. The hand tool is used to move, add, or delete points. A point can be moved 

by left-clicking and dragging it to a new location. Conversely, it can be removed by right-clicking 
with the mouse. New points can be added by right-clicking anywhere on the contour. 
 

Holding the control (Ctrl) button while moving a line segment will restrict the movement 
of that segment in such a way that the line segment moves either in a direction parallel 
to itself or in a direction along itself (collinear with itself). A special case occurs when 
moving an interior line segment contained within the building footprint. In this case, the 
line segment will also resize itself to fit within the building footprint. Note, however, the 
line segment may not resize itself if the building footprint is irregular. 

 
The edge merging option is enabled by default. When enabled, edges will be merged as long 
as they are collinear and represent the same line.  
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When using the hand tool to add a point, that point may “disappear” if it was added to 
a straight line. This is because the edge merging tool is enabled. The edge merging tool 
“sees” this point as splitting a line segment into two collinear line segments and 
consequently merges them. Hence, the edge merging tool should be disabled to split a 
straight line into two parts.  

 
All angles of a selected building contour that approach ninety (90) degrees can be rectified. 
The rectify operation changes these angles to be as close to ninety (90) degrees as possible. 

 
The software automatically extracts 3D information from the DSM and determines the z-
value of each vertex of the polygon bounded by the contour. The polygon starts off as a 

plane representing the building. In most cases a building’s roof is more complex than a plane. For 
these situations, the “Add a surface” tool can be used to add further details to the building polygon. 
The ‘Add a surface’ tool is used to segment the building polygon into more planes to better represent 
the roof geometry. To segment the plane, left click and hold on any contour line of a building and 
drag the mouse to see a dotted line indicating the plane segmentation as shown in Figure 28.  
 

 
Figure 28: Plane segmentation indicated by the dotted line. 

 
The newly created dotted line indicates the building polygon is divided into two sections. The 
software automatically recalculates the new plane to be applied to each section and determines the 
z-value of each vertex. It uses the 3D information in the DSM for this calculation. The fact that the 
line is dotted indicates that the two new planes touch at their boundaries (e.g. two planes that create 
a roof slope). If the line was solid it would indicate that the boundary of one plane meets the other 
plane in an area other than the boundary, creating a discontinuity in elevation (e.g. when a small 
building is connected to a taller building). In other words, the software automatically uses the 
building contour (the outer most border of the building) and the dotted/ solid lines to fit planes 
within those boundaries. The user should segment the building polygon to create as many planes as 
necessary to represent all the various slopes in the roof geometry of a particular building.  
 
In addition to segmenting planes by clicking on the edges, points can likewise be dragged to divide 
the polygon into different slopes. New points can also be added by right-clicking on the feature 
lines. 
 

If the surface merging option is turned on, planes that are coplanar and that represent the 
same surface will be automatically merged together as the user is modifying the building. 
 

Visual feedback is provided based on how well planes fit within their surfaces. In particular, as the 
user is segmenting the polygon to better define roof geometry, the software automatically 
calculates how well a particular surface can be represented by a single plane. If a plane poorly 
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represents a surface, then that plane is shaded red. Likewise, if a plane represents a surface only 
marginally well, then it is shaded yellow. Otherwise, the plane fits a surface well and is shaded green. 

 
The best fit function uses the information in the DSM to improve the position of the planes. 
The criterion for moving vertices is based on which configuration will result in the best fit 

for the planes. Note this might not necessarily correspond to the best visual positioning of the 
contour. If the position of the points is already optimal, then the best fit function will not perform 
any further changes. 
 

Note that elevation values for each vertex can also be manually set. Use this function to 
select any vertex and change the elevation value. 
 

9.1.2 Road Extraction Mode 

This mode allows the user to extract road features. The user traces out the road using the 
mouse. For each vertex of the polygon, the median elevation within a fixed boundary inside 

the polygon is taken as the road height. This accounts for any banking or slopes the road may 
traverse. 
 

9.1.3 Waterbody Extraction Mode 

This mode allows the user to extract water surfaces. The user traces out the water boundary 
using the mouse. For each vertex of the polygon, the median elevation within a fixed 

boundary outside the polygon is taken as the water height. This means that there must be some 
ground clearing around the waterbody in order for the polygon to take on appropriate values. 
 

9.1.4 Forest Extraction Mode 

This mode allows the user to extract forests. As in building extraction, this mode uses 
contour fitting. Hence, the user needs only to make a rough selection around the forest area 

and the software will automatically squeeze the selection to the forest boundary. The elevation 
applied will be a local average at each vertex. 
 
Table 6 summarizes the keyboard shortcuts that can be used when extracting features. 
 

Action Keyboard Shortcut 
Switch between Move a Point and Add a Surface Tab 
Surface Merging Ctrl + U 
Edge Merging Ctrl + E 

Table 6: Shortcuts for feature extraction tools 
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9.2 Attributes 

Attributes may be applied to each feature. To apply an attribute to a feature, the user needs to first 
select that feature and enter corresponding information.  New fields can also be created to suit the 
user’s requirements. Moreover, an XML file can be provided containing a user’s desired attribute 
list. The information in this XML file will be loaded automatically. To specify the XML file, please 
select "Feature Attribute File" in "General Settings" which can be accessed from the "File" menu. 
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9.3 Real-time True Orthorectification 

A true ortho can be created for a small region in real-time around a selected feature. To 
allow for true orthorectification, the necessary inputs need to be specified when entering 

feature extraction mode. The user then proceeds to the feature extraction process. At any time, the 
user can enable true ortho generation by toggling the "Display real-time true ortho" button. Note, 
as the user continues editing the selected feature, the true ortho will be automatically updated to 
reflect the changes. This enables the user to iteratively refine the polygon for the selected feature 
until the true ortho is a perfect fit. 
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10 DISTRIBUTED PROCESSING 

Correlator3D™ can benefit from the computers available on a local network to increase its 
processing power by multiple folds. The software can dynamically distribute processing tasks and 
manage communication with other stations with the software installed. It can also automatically 
handle situations in which a station goes suddenly offline during processing, or another becomes 
available, without the user having to intervein. 
 
While the integration of these capabilities to Correlator3D™ is seamless, some aspects need to be 
considered when installing and operating the software. 
 

10 



Distributed Processing | 81 

10.1 Installation 

When installing the software, the wizard specifically asks to install a special service used to 
automatically detect other stations equipped with Correlator3D™on the local network. Note that 
each station must have a valid software license (local or network) in order to perform processing. 
 

 
Figure 29: Service installation. 

 
This service requires to be associated to a user with sufficient privileges to access common network 
folders used during processing (this user does not necessarily have to be the same on all stations). 
Note that even if another user is logged into the station, the service will still be associated to the 
user specified during the installation. This service will also be automatically started each time the 
computer is restarted. 
 
While the installer will attempt to automatically add special rules to the Windows firewall, other 
firewalls may require to manually add them. Specifically, the following ports need to be accessible:  
 

C3DProc.exe: port 41831 (outbound), TCP and UDP 
C3DNetDiscovery.exe: 41832 (outbound), TCP and UDP 
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10.2 Settings 

The settings related to the distributed processing can be found in the General Settings of the 
application (“File” menu). A critical aspect when enabling distributed processing is to make sure that 
the temporary folder of the main station is accessible to all processing stations. This is essential since 
this folder is where the remote stations will store the results of their tasks. If this folder is on a local 
disk of the main station, it first needs to be shared to the network. Then, it must be specified using 
the corresponding network address (e.g. “\\COMPUTER123\SharedTemp\”) in the general settings, 
even if this folder is local. 
 

 
Figure 30: Distributed processing settings. 

 
Other options can also be set such as the name of the processing group a station belongs to. 
Permissions can also be set to define which remote stations can access this station, or even to deny 
access to others. 

 
At any given time, the Processing Station List window can be displayed using the 
corresponding button of the main toolbar. This window displays the processing stations that 

were automatically detected on the local network as well as their status. The most typical statuses 
are: 
 

­ Available: The station is available for processing. 
­ Ready: The station is locked by the main station, and ready to start processing. 
­ Busy: The station is currently being used by another station. It can also mean that 

the Correlator3D™ interface is opened on this station. 
 

 
Figure 31: Processing station list. 

 
In case of an error, the user can hover the cursor over a status to get further details. This window 
also allows to select, with the corresponding checkboxes, which station should be used for any 
oncoming process. Stations that were not automatically detected can also be added using the 
corresponding button. 
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10.3 Project Creation 

Four processes can be distributed: aerial triangulation (tie point extraction), DSM generation, 
orthorectification, and 3D model generation (texture generation). When the user defines the 
parameters in the corresponding dialog, the processing station list will automatically be displayed in 
the project tree. The user can then verify which stations are currently ready for processing. 
 
During processing, the user can assess the workload by monitoring in real-time the number of tasks 
that have been processed so far by each station. At any given time, it is possible check or uncheck 
a station to dynamically adjust the computing power. 
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10.4 Processing 

Projects for which distributed processing is desired also need special attention at the time of 
creation. Input files (e.g. images) and project folder must be accessible to all processing stations. 
Again, if these files are on a local disk of the main station, they first need to be shared and added to 
the project using a network address. 
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10.5 Performance 

As photogrammetry projects usually consist of a considerable amount of data, extra care must be 
taken when choosing hardware. Specifically, the performance of the disk containing the images must 
allow fast access times as several stations will read and write data simultaneously. Consequently, 
the network must also support large bandwidth. Therefore, the following hardware is recommended 
to fully benefit from this capability: 
 

­ PCI Express NVMe Solid State Drives  
­ 10 Gigabit PCI Express network adapters 
­ 10 Gigabit network switch 
­ Cat6 Ethernet cables or better 
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11.1 Import EO Data 

Correlator3D™ features a tool to import EO data. The tool allows to load EO data stored in a file 
(ASCII format) and to arrange it according to the SimActive format. In the original file, the EO data 
must be ordered by columns, and the tool assigns specific columns to particular EO values (i.e. image 
name, easting, northing, elevation, omega, phi, and kappa). If the software automatically detects EO 
values in the EXIF metadata of the images, the table will be populated with these values. 
Additionally, the interface allows the user to ignore specific rows or columns, edit individual cell 
values, and remove unwanted lines. 
 
The user must specify in which units the angular values are represented (degrees, radians or 
gradians) and the tool will convert them, if necessary, to degrees.  An angular offset can also be 
added to kappa values by using the “Camera Mount Rotation” option.  In addition, if values in the 
“ImageName” column do not include a file extension (e.g. tif, jpg or bmp), then the tool can 
automatically add one using the “Add Extension to Image Name” option.   
 
The user must select a position and orientation system. The software operates using the 
"Easting/Northing" position and the "Omega/Phi/Kappa" orientation systems. However, a 
"Lat/Long" position and/or "Roll/Pitch/Yaw" orientation system may be specified. The tool will then 
perform the necessary conversion. Note, the user must specify a projection to allow conversion 
between different position and orientation systems. The orientation system can also be set to 
"Automatic". This will set omega and phi angle values to zero, and the kappa will be derived from 
the image positions. 
 
An additional option, “Altitude/Geoid Offset”, allows the user to specify a vertical offset related to 
a geoid or another reference. This option is presented as a drop-down menu where the user can 
choose, if required, a geoid model to apply to the elevation values. The available geoid models are 
EGM84, EGM96, and EGM2008. If one of these models is selected, the software will automatically 
retrieve the appropriate offset value based on the image positions. Alternatively, it is also possible 
to manually specify an offset value if needed. 
 
If additional geoids are required, these can be added through the software’s Config.txt file by adding 
the following line: 
 

ExtraGeoids    geoid1.tif, geoid2.tif, … 
 
These geoids will be automatically integrated into the interface. A comprehensive list of available 
geoid files can be found at https://cdn.proj.org/, and Correlator3D™ will download them as needed. 
If internet access is unavailable, please contact the support team for assistance. 
 
To create an EO file, the user should perform the following operations: 
 

1. Specify an ASCII file by pressing the corresponding "..." button. 
2. Specify the delimiter(s) to be used by the software to recognize the columns in which EO 

data are represented. 
3. Specify the input angular units. 
4. If required, specify a camera mount rotation to add an angular offset to the kappa values. 
5. If required, specify an extension to be added to image names. 
6. Select the appropriate position and orientation system. 
7. Select the altitude units. 
8. If required, specify an altitude offset. 
9. Assign EO data values to the appropriate columns by pressing on the buttons located at 

the top of the displayed ASCII file.   
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10. Remove any undesired rows by clicking on the corresponding check box located at the 
beginning of a line. 

 

 
Figure 32: EO file creation dialog. 
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11.2 Import LIDAR LAS 

Correlator3D™ can import LIDAR LAS files. If the “Extract DEM” option is selected, the software 
will automatically determine the resolution of the point cloud and create a regular grid, i.e. a DEM. 
The resulting DEM can then be used to extract tie points (as a reference DEM), tag GCPs, 
orthorectify images, etc. The resolution can also be manually specified. 
 
Similarly, if the LAS files contain intensity information and the “Extract Image” option is selected, 
the software will create a reference ortho that will be added to the project tree. The reference ortho 
can then be used to extract tie points (as a reference ortho), tag GCPs,  and assess the quality of the 
project. 
 
To import LIDAR LAS files, the user should perform the following operations: 
 

1. Select “Import” -> “LIDAR LAS File…” from the “File” menu. 
2. Specify the files to be imported by clicking on the “Add Files…” button. 
3. Specify the desired resolution.  Press the “Optimal” to compute the resolution of the LIDAR 

LAS files automatically. 
4. Select “Extract DEM” if a DEM is required. 
5. Select “Extract Image” if a reference ortho is required. Specify the folder and the name of 

the resulting ortho. 
6. Click on the “Process” button.  
7. Save the generated DEM by selecting “Save DEM As…” using the contextual button in the 

project tree. 
 

 
Figure 33: Import LIDAR LAS dialog. 

 



Tools | 90 

11.3 Seed DEM Creation 

Correlator3D™ offers a tool to automatically create a seed DEM. The software creates a DEM with 
the boundaries computed from the provided project and with every elevation point set at the 
specified terrain height. 
 
To create a seed DEM, the user should perform the following operations: 
 

1. Select “Seed DEM Creation…” in the “Processes” menu. 
2. Specify the average terrain height. 
3. Click on the “Process” button.  Real-time feedback on the overall progress of processing 

will be provided. Once the process is done, the seed DEM will appear in the main window. 
 
 

 
Figure 34: Seem DEM creation dialog. 
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11.4 Fiducial Detection 

Correlator3D™ features a tool for automatically detecting fiducials.  The tool is useful for extracting 
the position of marks (in pixels), which are necessary for using any processing module of the 
software with scanned films.  The fiducial detection tool is shown to the user when creating a project 
with scanned films.  
     
Correlator3D™ supports fiducial marks that consist of two lines intersected in a perpendicular 
manner.  These two lines can be continuous or not and the corresponding cross mark can be oriented 
in any way.  Also, note that fiducials are assumed to be bright on a black background. 
 
Fiducial detection is performed in four steps: 
 

1. The user enters the required information in the fiducial detection dialog. 
2. The user manually selects the fiducial marks for the first image. 
3. Correlator3D™ automatically detects the fiducial marks for the remaining images. 
4. Correlator3D™ automatically validates the detection results and prompts the user to 

manually select the fiducial marks for faulty images. 
 
Detection results can be verified visually using images that the software automatically generates 
(these can be found in the temporary folder as described in Section 15.3).  The figure below shows 
an example of a successful fiducial detection.  Note that the center of the green mark represents 
the location where the software located a fiducial mark. 
 

 
Figure 35: Sample fiducial detection results. 

 
Fiducial marks that are incorrectly detected can be easily identified by looking at these images.  The 
following figure presents such a situation.  In that case, the user should manually correct the 
resulting exterior orientation file.  Note that a warning will be reported in the log file (Section 15.1) 
when there was an error in the detection process.  
 

 
Figure 36: Sample fiducial detection results with one mark incorrectly identified. 

 

The user can skip the automatic detection phase and manually select the fiducial marks. 
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To use the fiducial detection tool, the user should perform the following operations: 
 

1. Drag each of the four images until a fiducial mark appears in the center of each frame under 
the green marks. 

2. Turn on the "Skip automatic detection" if all fiducial marks need to be selected manually. 
3. Click on the “OK” button when all fiducial marks are correctly selected. 
4. Automatic detection is performed and real-time feedback on the overall progress of 

processing is provided. 
5. Automatic detection of faulty images is performed. If necessary (or if the "Skip automatic 

detection" was turned on), the fiducial detection dialog for manual selection appears and 
these steps must be performed: 

a. Drag the faulty fiducial marks under the corresponding green marks. 
b. Click the “Next” button. 
c. Repeat steps a) and b) until process is completed. 

 
When using the fiducial detection dialog for manual selection, the size of the fiducial marks can be 
adjusted by using the “+”, “-“ and “1:1” buttons. The fiducial marks are selected by dragging their 
image portion over the intersection of green lines, either by using the mouse or the arrow keys on 
the keyboard. If the arrow keys are used, “Shift” and “Ctrl” keys can serve for coarser, but faster 
positioning, while the arrow keys alone are better suited for fine-tuning purposes. 
 

        
Figure 37: Fiducial detection dialogs for manual selection. On the left, all fiducial marks were 

correctly selected. On the right, a faulty detection must be corrected. 
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11.5 Calibrated Reflectance Panel Creation 

For multispectral camera projects, the user might require to use calibrated reflectance panels to 
calculate reflectance information for each image. These panels are used to compensate for the 
lighting conditions at the time of each survey, allowing comparison over different days or at different 
times of the day. Images of the panels are usually taken before and after each flight to provide an 
accurate representation of the amount of light reaching the ground at the time of capture. 
 
Calibrated reflectance panels must be added before orthorectifying the images since the reflectance 
information is calculated at this time. Panels are added to a project on a per-image basis. In other 
words, a same panel can be taken in several images over time and by several cameras, and will 
consequently need to be added several times to the project. For each panel, the calibrated 
reflectance (or albedo) values must be known for each wavelength. These values are usually 
provided by the panel manufacturer. 
 

If more than one panel image is captured (for example at the beginning and end of a 
flight) or if data are captured in multiple flights, and a calibration panel image is taken 
at the beginning of each flight, the software will extend the analysis by interpolating 
across time. 

 
To add a calibrated reflectance panel, the user must hover the cursor over the camera used to 
capture the image, under the Reflectance Panel portion of the project tree, and press the “Add a 
panel” contextual button. 
 

 
Figure 38: Calibrated reflectance panel dialog. 

 
The following operations must then be performed: 
 

1. Specify an ID for the panel. It could consist of the ID of the panel, and the time at which it 
was captured. 

2. Select the camera that was used to capture the panel. 
3. Click on the "Add Images" button to select the corresponding image. If images generated 

by the camera has one file per band, then select the corresponding files. The total number 
of images should be at most the total number of bands of the camera. 

4. For each band, specify the calibrated reflectance (or albedo) value. 
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5. Click on the "Next" button. 
6. Click on the center of the panel to indicate its location. The software will then start 

automatic detection of the panel in each image/band. 
7. Visually inspect the boundaries of the rectangle to make sure it matches the panel and drag 

the corners if it is required. 
8. Click on the "Next" button and adjust the boundaries in all other images/bands. 

 

Some calibration panels include a QR code that are automatically recognized by 
Correlator3D™. Consequently, the dialog are pre-filled with the calibrated reflectance 
values, and the boundaries of the targets are already selected. 

 
Figure 39: Panel boundaries dialog. 
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11.6 GCP Creation 

Correlator3D™ features a tool to create GCPs for UAV/medium/large format and satellite sensors.  
The GCPs are used during the aerial triangulation process.  The tool enables the user to specify pixel 
coordinates of ground control points in a visual environment. GCPs may be created by specifying 
their positional coordinates. The software uses these inputs to automatically determine which 
images contain the specified GCP.  These images are then displayed in the visual interface and the 
user is requested to pinpoint the locations of ground control points. 
 

The GCP creation tool is only available in the AT module. 

11.6.1 Creating and Importing GCPs 

There are three methods for creating GCPs. The first method is by using the project tree where the 
user must hover the cursor over the GCP portion, and press the “Add a new point” contextual 
button. The GCP editing dialog will then be displayed to manually specify the coordinates of the 
GCP. 

 
The second method is by directly clicking on a specific location in the main window using 
the “Create a GCP” tool from the aerial triangulation toolbar. It will automatically trigger the 

GCP Editing dialog, with all the coordinates of the GCP already filled. If a DEM, a point cloud or a 
3D model are simultaneously loaded in the project, the software will first ask for what elevation to 
be used for the GCP. 
 
Finally, when GCPs are already specified in a text file (in ASCII format), they can be imported in the 
aerial triangulation module. The file should be organized in columns such that the tool can assign a 
specific column to a GCP field (i.e. GCP ID, X, Y, and Z).  The interface also allows ignoring some 
rows or columns. Imported GCPs are then displayed in the project tree where they must be selected 
for editing in order to add observation data. 
 
The following operations must be performed to import a GCP file: 
 

1. In aerial triangulation mode, select “Import GCP File…” in the “Processes” menu. 
2. Specify an ASCII file by pressing the corresponding "..." button. 
3. Specify the delimiter(s) to be used by the software to recognize the columns in which GCP 

data are represented. 
4. Specify the projection system of the coordinates to be imported. 
5. Choose if the new GCPs should be added to the existing ones or should replace them. 
6. Assign GCP data values to the appropriate columns by pressing on the buttons located at 

the top of the displayed ASCII file.   
7. Remove any undesired rows by clicking on the corresponding check box located at the 

beginning of a line. 
8. Click on the “Import” button. 
9. Add observation data to each GCP by editing them using the corresponding button in the 

project tree. 
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11.6.2 GCP Editing Dialog 

The GCP Editing dialog is used to edit GCP properties, such as its ID, description and coordinates, 
and to tag it in the images. The dialog is divided into four sections: 
 

­ Information: this section is located at the top of the window and contains the GCP 
properties. For convenience, it can be collapsed using the blue triangle button in the upper-
right corner. 

­ Observations: this section occupies the largest part of the window. This is where the user 
can adjust the location of the GCP in the images. 

­ Ribbon: this section is located under the observation section. It contains an overview of all 
the observations of the GCP along with other images in which the GCP is likely to be found.  

­ Zoom and Navigation: this section can be found at the bottom of the dialog. It contains 
controls to help navigate the images. 

 

 
Figure 40: GCP Editing window. 

 
 
There are four (4) GCP types which are "GCP", "GCP_XY", "GCP_Z" and “check point”. The first three 
types are used to distinguish between varying forms of positional certainty. For example, the user 
may need to specify a GCP for which they are only certain about the Z component. In this case, GCP 
type "GCP_Z" will be used. Note, the user will still have to specify an approximate X and Y 
component. The effect of this is that the software will now treat this GCP accordingly in the aerial 
triangulation process, placing a high importance on the Z component, while allowing room for error 
in the X and Y components. Check points are GCPs that are not taken into consideration when 
performing bundle adjustment. They are generally used for quality assessment.  
 

GCP TYPE Certain Uncertain 
GCP XYZ None 
GCP_XY XY Z 
GCP_Z Z XY 

Table 7: GCP type description. 
 



Tools | 97 

The user has the option to add uncertainty information. As described in in section 7.1.5, when the 
uncertainty values are left blank, the general uncertainty values will be applied during bundle 
adjustment. If an uncertainty value is specified in the GCP Editing dialog, it will overwrite the general 
uncertainty values for this specific point. This way, the user can specify a global uncertainty for all 
points and redefine it on a point-by-point basis. If uncertainty is used, it must be specified for all 
three coordinates (X, Y, and Z).  
 
Once coordinates are specified, Correlator3D™ will project the point in each image and populate 
the ribbon with the images that most likely contain the GCP. The software uses knowledge on 
already identified GCPs and current IEO parameters to select the best image candidates. 
Consequently, each time a new GCP is added to the project, Correlator3D™ becomes better at 
selecting candidate images.  
 
The observation section of the dialog will display up to three images depending on the window size. 
These are used to adjust the GCP location in each image. Initially, an image candidate has an 
“unspecified” state. This state indicates that the user has not yet validated nor discarded the image. 
To validate an image, the user must adjust the GCP location in that image by clicking and dragging 
the image until the green aim is on top the GCP. 
 

If the GCP is already at the proper location, the image can be validated by pressing the green 
aim button on the top-right corner of the image. 

 
An image can also be discarded by checking the red discard button next to the green aim 
button.  

 
Unchecking both the aim button and the discard button will revert the image back to the unspecified 
state. Images in the disabled or unspecified state will not be used during bundle adjustment as there 
is no functional difference between both. The disabled state exists to let the user differentiate 
images that have been rejected from those that require attention. 
 
The ribbon is used to navigate around the image candidates. The blue rectangle indicates which 
images are currently displayed in the observation section of the window. To change the images 
being edited, the user can drag and drop the ribbon at the proper location. An alternate option is to 
use the arrows on the left and right side of the ribbon or those under the ribbon. 

 
When the ribbon is dragged completely to the left (therefore showing the rightmost part of 
the ribbon) a special “+” button is visible. Clicking this button will add new image candidates 

to the ribbon. 
 
At any time, the user can jump to a specific image by selecting it in the combo-box located above 
the left image in the observation section of the dialog. If necessary, the image will be added to the 
ribbon. 
 
Each time the location of the GCP is adjusted in an image, the software recalculates the estimated 
location of the GCP in the images marked as “unspecified”. The ribbon is updated in real time to 
reflect these adjustments. This means that each new observation for the GCP improves the 
estimated location of the GCP in the other images. 
 

Scrolling the ribbon is a fast and easy way to identify and validate the GCP observations. 

 
The zoom options located in the lower-left of the window are used to adjust the zoom factor applied 
to the images displayed in the observation portion of the dialog. Cancel and save buttons are located 
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in the lower-right of the window. Clicking “Save and Close” will update the GCP. Clicking “Cancel” 
will discard the changes and close the window.  
 
To edit a GCP, the user should perform the following operations:  
 

1. Fill the required ID (name), type, projection and XYZ coordinates properties. If required, add 
a description and an uncertainty. 

2. Mark which images are to be used with the GCP. 
a. Use the ribbon to navigate between the images. Use the “+” button to add images 

if necessary. 
b. Adjust each image to tag the exact GCP location. Use the zoom options to help find 

the exact location of the GCP. 
3. After all the observations have been added click the “Save and Close” button to update the 

GCP file. 
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11.7 DEM Merging 

Correlator3D™ DEM merging tool allows combining DSM or DTM results that were created 
separately.  It is useful to process a project in multiple parts (e.g. at different times or in parallel on 
multiple machines) and merge different tiles of DEMs together afterward.  It can also help to recover 
intermediate results from individual pairs when, for some reason, the DSM process is interrupted.  
Correlator3D™ implements an intelligent data fusion approach that leads to consistent data sets, 
even when there are minor discrepancies along adjacent tile boundaries.   
 
The DEM merging tool can be accessed from the Tools menu and does not require any DEM to be 
loaded in the main window.  It can merge files stored in different formats and horizontal resolutions.  
Note that when merging DEM sets having different horizontal resolutions, the resulting data will 
automatically inherit the finest resolution.  Also, if there is no overlap between adjacent data sets, 
Correlator3D™ will set the corresponding elevation values as undefined.  An option to fill gaps in 
the resulting DEM is also available.  This option allows the user to get a DEM in which small areas 
where elevation values were left undefined are filled with interpolated terrain data.  The final 
merged data will be displayed in the main window and can then be saved by the user. 
 
To merge DEMs, the user should perform the following operations: 
 

1. Select “DEM Merging…” in the “Tools” menu. 
2. Specify the files to be merged by clicking on the “Add Files…” button.  A file browser will 

appear.  Select the files to be added and click “Open”.  The list will then be updated.  Note 
that all files can be removed from the list (e.g. in case of an error) by pressing on the “Clear 
List” button. 

3. Click on the “Merge” button.  Real-time feedback will be provided on the overall progress 
of processing.  Once the process is done, the resulting DEM will appear in the main 
window. 

4. Save the merged DEM by selecting “Save DEM As…” in the “File” menu. 
 

 
Figure 41: DEM merging dialog. 
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11.8 Export EO and Camera Parameters 

Correlator3D™ can export the EO information and camera parameters. In order to perform this, the 
user must specify a folder in which the information is saved.  In the case of a frame-based project, 
one EO file and one calibration file per camera will be created.  For satellite projects, one RPC file 
will be produced for each image.  These files will be exported as simple text files, which can be used 
later on in the software. 
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11.9 Export Mosaic 

Users can export the final mosaic using a tile definition file and selecting the type of mosaic they 
want to create. Standard mosaics, index maps, and reflectance maps can be created. Users can 
export only a portion of the mosaic using the "Crop Area" option, as defined by a polygon stored in 
a DGN file or a Shapefile. 
 
Users can either specify a fixed size for the tiles, individual tile size and coordinates through a tile 
definition file or ask for a single tile.  If a fixed tile size is specified in the dialog, each tile will have 
that size, except for tiles located on the border of the mosaic.  In such cases, the size of the tile is 
simply reduced to remove unnecessary undefined areas. The tiles are created to be juxtaposed one 
after the other with no overlap between two adjacent tiles. The naming of the tiles describes the 
spatial relation between each other. The name convention is as follows: 
Name_LineNumber_ColumnNumber.tif. 
 

The position and orientation of the input orthorectified images can lead to situations 
where some tiles only contain undefined data (completely black areas). When specifying 
a fixed tile size in the Export Mosaic dialog, if such a situation occurs, the corresponding 
tiles are not created by Correlator3D™. This behavior is part of an optimization effort to 
reduce memory and disk requirements while improving overall performance. 

 
If a tile definition file is used, then the tile size specified will be respected, even if the resulting area 
contains unnecessary undefined areas. Moreover, each tile will be created even if they do not 
contain any data at all. 
 
To export a mosaic, the following steps must be performed: 
 

1. Specify the Mosaic Type. Click on the corresponding settings button to specify the band 
ordering or the index type if required . 

2. Specify the Mosaic Folder that will contain the mosaic using the corresponding drop-down 
menu. 

3. Specify the file format of the mosaic. 
4. If a Crop Area is used, specify the constraint. 
5. Specify the Tile Definition File if required. 
6. If no Tile Definition File is used: 

a. Specify the name for the mosaic.   
b. Specify the tile size or the Single Tile option. 

7. Click on the “Process” button. The mosaic will then be exported using the parameters 
specified. 
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Figure 42: Export mosaic dialog. 

11.9.1 Index Map 

A mosaic can be converted and exported to an index map. Users can choose from a list of predefined 
indices including: 
  

– NDVI 
– BNDVI 
– GNDVI 
– LCI 
– NDRE 
– SIPI 
– SIPI2 
– ARVI 
– GCI 
– NBR 

 
Custom indices can also be specified through a formula. This formula supports different operations 
between the imagery bands, including addition, subtraction, multiplication and division. The 
resulting index can be outputted either as a floating point value or following a color map. This color 
map is defined by the number of classes (colors), as well as the bounds of the index. 
 

If reflectance information is available, it will be used to calculate indices, thus providing 
even more accurate maps. Reflectance information is only available for multispectral 
projects for which the sun sensor or calibrated reflectance panels were used during 
orthorectification. 
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Figure 43: Index settings dialog. 

 

11.9.2 Reflectance Map 

If reflectance information is available, a mosaic can be exported to a calibrated reflectance map. 
Reflectance information is only available for multispectral projects for which the sun sensor or 
calibrated reflectance panels were used during orthorectification. 
 
The resulting reflectance map will be outputted as 32-bit floating point values ranging between 0 
and 1, with undefined pixels set to -1. The map will contain as many bands as the input imagery. If 
an infrared band is available, it will also be outputted in the same file as 32-bit floating point values, 
corresponding to the temperature in Kelvin. 
 

If a mosaic containing reflectance information is exported with the “Standard” option, 
reflectance values of each band will be stretched independently between 0 and 2N-1, 
where N corresponds to the number of bits of the input imagery. 

 



Tools | 104 

11.10 Export DEM 

11.10.1 Export DEM Tiles 

Correlator3D™ can divide a DEM in multiple tiles. The user can either specify a fixed size for the 
tiles or specify individual tile sizes and coordinates through a tile definition file.  If a fixed tile size is 
specified in the dialog, each tile will have that size, except for tiles located on the border of the DEM.  
In such cases, the size of the tile is simply reduced to remove unnecessary undefined areas. The tiles 
are created to be juxtaposed one after the other with no overlap between two adjacent tiles. The 
naming of the tiles describes the spatial relation between each other. The name convention is as 
follows: Name_LineNumber_ColumnNumber.tif. 
 

The shape of the input DEM can lead to situations where some tiles only contain 
undefined data (completely black areas). If such a situation occurs when specifying a 
fixed tile size in the Export DEM Tiles dialog, the corresponding tiles are not created by 
Correlator3D™. This behavior is part of an optimization effort to reduce memory and 
disk requirements while improving overall performance. 

 
If a tile definition file is used, the tile size specified will be respected, even if the resulting area 
contains unnecessary undefined areas. Moreover, each tile will be created even if they do not 
contain any data at all. 
 
The format of the output DEM tiles can be specified in the dialog.  If a definition file is used, the 
format is specified through the extension of the DEM tiles. 
 
The tool can be accessed from the File menu and requires a DEM to be loaded from the project tree.   
 
To export DEM tiles, the following operations should be performed: 
 

1. Select a DEM from the project tree.  The DEM will be displayed in the main window. 
2. Select “Export” -> “DEM” -> “DEM Tiles…” in the “File” menu. 
3. If a tile definition file is used 

a. Select “Tile Definition”. 
b. Specify the tile definition file by pressing on the corresponding "..." button. . 

4. Specify the folder that will contain the tiles by pressing on the corresponding "..." button. 
5. If no tile definition file is used 

a. Specify the name for the mosaic.   
b. Specify the tile size. 

6. Specify the format for the DEM tiles. 
7. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing. 
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Figure 44: Export DEM tiles dialog. 

11.10.2 Export LIDAR LAS and ESRI Shapefile 

Correlator3D™ can export a DEM into a LIDAR LAS file or an ESRI Shapefile.  Using these formats, 
elevation grids will be exported as a series of 3D points.  The tools can be accessed from the File 
menu and requires a DEM to be loaded in the main window.   
 
To export a DEM into the LIDAR LAS or ESRI Shapefile format, the user should perform the 
following operations: 
 

1.  Select a DEM from the project tree.  The DEM will be displayed in the main window. 
2. Select “Export” -> “DEM” -> “LIDAR LAS File…” or “ESRI Shapefile”   in the “File” menu. 
3. Specify the name and the location of the file to be exported. 

11.10.3 Export with Geoid 

Correlator3D™ can export a DEM on which a geoid will be applied.  The geoid file must be provided 
in the GTX or TIF file format. Geoid files can be easily found at https://cdn.proj.org/. 
 
The tool can be accessed from the File menu and requires a DEM to be loaded in the main window.   
 
To export a DEM with a geoid, the user should perform the following operations: 
 

1. Select a DEM from the project tree.  The DEM will be displayed in the main window. 
2. Select “Export” -> “DEM” -> “With Geoid…” in the “File” menu. 
3. Specify the geoid file by pressing on the corresponding "..." button. 
4. Specify the output DEM by pressing on the corresponding "..." button. 
5. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing. 
 

 

 
Figure 45: Export with geoid dialog. 
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11.11 DEM Inspection 

Correlator3D™ DEM inspection tool is used to generate statistics about the quality of a DEM against 
reference data, i.e. elevation points provided in a ShapeFile or a SimActive GCP file.  The software 
automatically computes the differences in elevation and provides statistics including bias error, 
standard deviation, RMS error and maximum error. 
 

Statistics are displayed in a window at the end of the process. They can be saved as a 
text file. 

 
To export DEM tiles, the following operations should be performed: 
 

1. Select “DEM Inspection...” in the “Tools” menu. 
2. Specify the DEM to be inspected using the corresponding drop-down menu. 
3. Specify the reference data using the corresponding drop-down menu. 
4. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing. 
 

 
Figure 46: DEM inspection dialog. 
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11.12 Change Detection 

Traditionally, change detection is performed by comparing two images.  This approach is not robust 
in general since only changes in the appearance of the scene are detected and such changes do not 
necessarily imply structural changes.  Correlator3D™ allows change detection by comparing DEMs 
instead of images.  Such a comparison is possible since the software can quickly and automatically 
process 3D data. 
 
Correlator3D™ requires two DEMs, which should be generated from two different image sets of 
the same area.  It performs a comparative analysis and determines in 3D the importance of changes.  
The software outputs change detection results as a DEM with values corresponding to the 
differences in elevation between the two DEMs.  The results can be optionally outputted as color 
information superimposed on a mosaic of orthophotos.  This mosaic gets converted to grayscale 
and structural changes are highlighted using a specific color scheme: negative elevation changes 
(e.g. objects that have disappeared) are displayed in tones of yellow to red according to their 
importance (small to large changes respectively) while positive elevation changes (e.g. new objects) 
are shown in tones of dark to light blue (small to large changes respectively).  A detection range in 
meters is used and only changes that are within the specified range (vertically) will appear. 
 
 
To perform change detection, please follow these steps: 
 

1. Select “Change detection…” in the “Tools” menu. 
2. Specify the reference DEM (i.e. the DEM as it appears before changes) using the 

corresponding drop-down menu. 
3. Specify the comparison DEM (i.e. the DEM as it appears after changes) using the 

corresponding drop-down menu. 
4. If a change detection mosaic is required: 

a. Turn on “Display Changes on Mosaic”. 
b. Specify the “Input Mosaic File” of the input mosaic using the corresponding drop-

down menu.  This file can be either a mosaic definition file or a tile definition file. 
Change detection results will be overlaid on the mosaic after the processing is 
completed.  This mosaic can correspond either to the images taken before or after 
the changes. 

c. Specify the folder where the change detection mosaic will be generated using the 
corresponding drop-down menu.   

 

If new 3D structures are mostly expected, then the mosaic corresponding to 
the image data taken after changes should be used.  If it is anticipated that 
structures have in general disappeared, then the input mosaic should consist 
of the image data collected before changes have occurred. 

5. Specify the detection range.  This implies that only changes within that range (vertically) 
will be detected. 

6. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 
of processing.  Once the process is done, the change detection DEM will appear in the 
main window. 

7. Save the DEM by “Save DEM As…” in the “File” menu. 
 

 



Tools | 108 

 
Figure 47: Change detection dialog. 
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11.13 Point Cloud Filtering 

The Correlator3D™ point cloud filtering tool provides users with multiple filtering options to refine 
their point cloud data. Users can apply one or more of the following filtering types simultaneously 
by enabling the corresponding filter. Real-time visual feedback is provided to help users make 
informed decisions about which parameters to use. This allows users to focus on specific areas of 
interest within the point cloud with greater precision and accuracy by eliminating points that do not 
meet their desired criteria. 

11.13.1  Number of Observations 

This option allows users to filter a point cloud based on the number of observations assigned to 
each point during point cloud generation (an optional product of the DSM generation process). The 
tool contains a list of numbers, which correspond to each possible number of observations. For each 
number, there is a checkbox that users can uncheck if they do not want to keep points in that 
category. 

11.13.2  Elevation Range 

This filter type enables users to specify an elevation range to keep. Users can define the minimum 
and maximum elevation values, and only the points within this specified interval will be retained. 
This is useful for focusing on a specific elevation range within the point cloud data. 

11.13.3  Area 

The area filtering option allows users to specify a selection (e.g. ShapeFile) to define an area of 
interest. Users can choose to either keep points within the specified area (“Keep”) or exclude points 
outside the specified area (“Exclude”). This filter is particularly useful for isolating or removing points 
based on geographic boundaries. 
 
 

 
Figure 48: Point cloud filtering dialog. 
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11.14 Point Cloud Colorization 

The Correlator3D™ point cloud colorization tool is used to colorize a point cloud using a mosaic. 
The software automatically determines correspondence between 3D points and pixels. 
 

When colorizing a point cloud, it is strongly recommended to use an appropriate mosaic. 
As an example, if a point cloud was generated for a dense urban area, then the mosaic 
should be generated using true orthos, i.e. orthos generated on a DSM. Otherwise, 
discrepancies could be observed between points and colors. 

 
To perform point cloud colorization, the user must follow the listed steps: 
 

1. Select the point cloud to be colorized from the project tree. 
2. Select “Point Cloud Colorization” in the “Tools” menu. 
3. Save the modified point cloud by selecting “Save point cloud As…” using the contextual 

button in the project tree. Note that if the point cloud is saved under a different name than 
its corresponding DEM, it will be excluded from the project tree. 
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11.15 DEM Contour Extraction 

The Correlator3D™ DEM contour extraction tool is used to generate equally spaced contour lines 
from the currently loaded DEM and save them in a vector file. The contour lines are extracted based 
on two parameters: the interval, which corresponds to the elevation interval between contour lines, 
and the offset, which corresponds to the offset from zero relative to which to interpret intervals. 
 
To perform DEM contour extraction, the user can follow the listed steps: 
 

1. Select the DEM you wish to use for contour extraction from the project tree. 
2. Select “DEM Contour Extraction…” in the “Tools” menu. 
3. Specify the contour interval and offset. 
4. If a specific elevation attribute is required in the vector file, turn on the “Elevation 

Attribute” option, and specify the name of the attribute. 
5. Click on the “Process” button.  Real-time feedback will be provided on the overall progress 

of processing.  
6. Save the generated contour by selecting “Save contour” using the contextual button in the 

project tree.   
 
 

 
Figure 49: DEM contour extraction. 
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11.16 Pansharpening 

The pansharpening tool in Correlator3D™ allows users to enhance the spatial resolution of 
multispectral satellite imagery using a corresponding panchromatic image. It takes as input: 
 

- A multispectral image and its corresponding RPC file 
- A panchromatic image and its corresponding RPC file 

 
Using these inputs, the software produces a new pansharpened image along with an updated RPC 
file. The resulting product combines the spectral richness of the multispectral image with the finer 
spatial resolution of the panchromatic image. This process is fully automated and ensures that the 
generated RPC is properly aligned with the new image geometry. 
 
To perform pansharpening, the user can follow the listed steps: 
 

1. Select “Pansharpening…” in the “Tools” menu. 
2. Select the panchromatic image and its corresponding RPC file. 
3. Select the multispectral image and its corresponding RPC file. 
4. Specify the name and the output folder where the pansharpened image and updated RPC 

will be saved. 
5. Click on the “Process” button. Real-time feedback will be provided on the overall progress 

of processing. 
 
 
 

 
Figure 50: Pansharpening. 
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11.17 Splat Model Merging 

Correlator3D™ splat model merging tool allows combining splat models that were created 
separately.  It is useful to process a project in multiple parts (e.g. at different times or in parallel on 
multiple machines) and merge different tiles of splat models together afterward.  It can also help to 
recover intermediate results when, for some reason, the Gaussian splat generation process is 
interrupted.  Correlator3D™ implements an intelligent data fusion approach that leads to consistent 
data sets, even when there are minor discrepancies along adjacent tile boundaries.   
 
The splat model merging tool can be accessed from the Tools menu and does not require any splat 
model to be loaded in the main window.  It can merge files stored in different formats.  
 
To merge splat models, the user should perform the following operations: 
 

5. Select “Splat Model Merging…” in the “Tools” menu. 
6. Specify the files to be merged by clicking on the “Add Files…” button.  A file browser will 

appear.  Select the files to be added and click “Open”.  The list will then be updated.  Note 
that all files can be removed from the list (e.g. in case of an error) by pressing on the “Clear 
List” button. 

7. Click on the “Merge” button.  Real-time feedback will be provided on the overall progress 
of processing.  

8. Save the merged splat model by selecting “Save Splat Model As…” in the “File” menu. 
 
 
 

 
Figure 51: Splat model merging dialog. 
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12 RESULTS SHARING 

Once a project has been generated, the user can upload the results in the cloud. Correlator3D™ will 
then produce a secure link to an online data viewer that can be shared with customers or other 
users. This functionality is provided through Cesium, an end-to-end platform for tiling, visualizing, 
and analyzing 3D geospatial data on any device, including tablets and smartphones.  
 

Sharing the resulting link does not compromise the security of the Cesium account. This 
link will give access to the corresponding data only. 

 
To enable sharing, the following steps must be performed: 
 

1. Subscribe to Cesium. 
2. Setup a Cesium account. 
3. Link Correlator3D™ to a Cesium account. 

 
 

12 



Results Sharing | 115 

12.1 Cesium Subscription 

To subscribe to Cesium. The following steps must be performed: 
 

1. Select a data plan by visiting: https://cesium.com/pricing/ 
2. Create an account following the instructions from Cesium. 
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12.2 Cesium Setup 

Two new access tokens must be created using the Cesium web interface. The first token 
(C3D_Upload) will be used by Correlator3D to upload project data directly to the Cesium account. 
The second token (C3D_Share) will be used by Correlator3D to generate hyperlinks that can be 
shared with customers. The following steps must be performed: 
 
To subscribe to Cesium. The following steps must be performed: 
 

1. Login to your Cesium account (https://cesium.com/ion/signin/) using a web browser. 
2. Click on the “Access Tokens” tab. 
3. Click on the “Create token” button. 
4. Specify a name for the first token used for uploading (e.g. C3D_Upload).  
5. In the “Scope” section, turn on all the options. 
6. In the “Resources” section, select “All assets”. 
7. Click on the “Create” button. 
8. Specify a name for the second token used for sharing (e.g. C3D_Share).   
9. In the “Scope” section, turn on the “assets:read” option only. 
10. In the “Resources” section, select “All assets”. 
11. Click on the “Create” button. 
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12.3 Correlator3D™ Setup 

 
To link Correlator3D to a Cesium account, the following steps must be performed: 
 

1. In Correlator3D, in the “Share Results” dialog, select “Add…” from the drop-down menu in 
the “Cesium Profile” section. 

2. Specify a name and a description for your profile. This profile will contain the two required 
Cesium access tokens for uploading and sharing. 

3. In your Cesium account webpage, click on the “Access Tokens” tab. 
4. Select the “C3D_Upload” access token and copy the token string using the corresponding 

“Copy to clipboard” button. 
5. In Correlator3D, paste the token string in the “Upload” text box, in the “Cesium Access 

Tokens” section. 
6. Repeat steps 4 and 5, but this time for the “C3D_Share” token. Paste the string in the 

“Share” text box. 
7. Click on the “Ok” button. 

 

 
Figure 52: Cesium profile window. 
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12.4 Sharing Results 

To share results, the following steps must be performed:  
 

1. With a project already loaded in Correlator3D, click on “Share Results…” in the “File” menu. 
2. Select the Cesium profile to be used. 
3. Specify a name for your project. 
4. Specify the projection of the project if it was not previously specified during processing. 
5. Select the products to be uploaded. Note that for DEMs, point clouds and 3D models, only 

the products that are active (selected) in the project tree will be uploaded. 
6. Specify the band ordering of the imagery if required. 
7. Click on the “Ok” button. 
8. Once the project is uploaded to Cesium, a dialog with a shareable link to the online data 

will displayed. The same link can also be found in the log. 
 

Note that uploaded data can only be deleted using the Cesium account webpage. 
However, if a project with the same project name is uploaded, the corresponding data 
will be overwritten. 

 
 

 
Figure 53: Share results dialog. 
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13 SCRIPTING MODE 

Correlator3D™ includes a scripting mode for advanced users who desire to fully automate their 
processing tasks. 
 

13 
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13.1 Script 

A script simply consists of a plain text file containing a series of instructions that the software will 
execute sequentially.  The syntax is very simple: each operation starts with the process name and 
all necessary input/output parameters are then specified.  Here is an example for a DSM generation 
process: 
 

<DSMGeneration> 
{ 

  InputEO  C:\MyProject\IEO\Step_1\Step_1.ieo 
  Resolution  Optimal 
  VertAccuracy  Precise 
  OutputDEM  C:\MyProject\DEM\DSM.asc 

} 
 
Note that the order in which the process parameters are specified is not important.  The user can 
perform as many operations as desired. Input files that do not exist can be specified as long as 
previous operations create them.  For DSM generation and orthorectification, the optimal resolution 
or overlap can be set by entering “Optimal" (not case sensitive) in the corresponding field. Similarly, 
the user can set the maximal resolution by entering “Maximal” or “Coarse” in the corresponding 
field.  A description of the format of script files is included in Section 0. 
 
Once a script file is created, it can be run by selecting “Run Script…” in the “File” menu.  Real-time 
feedback on the overall progress of processing is provided during execution. 
 
Please refer to Appendix A for the script format description. 
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13.2 Command Prompt 

Instead of using the GUI to interact with Correlator3D™, the user may wish to use a command 
prompt to run individual scripts and batch files quickly. Navigate to the Correlator3D folder and 
type “C3D” to display the possible options. For example, the following command: 
 

C:\Program Files\SimActive\Correlator3D\C3D 
 
will display the possible options on the command prompt screen provided the software was installed 
in that directory.  
 
To run a script: 
 

 C:\Program Files\SimActive\Correlator3D\C3D PathToMyScript 
 
The list of commands is summarized in Table 8:  
 
 

Command Action 
/f Specifies the filename and path of the SimActive script file. "/f" is 

optional. 
/v Verbose mode. Displays all the messages on the overall progress of 

processing. 
/m Messages only. Date and time information is not displayed. 
/p Show progress on stdout. Displays progress information on the standard 

output stream. 
/s  <names> | <IPs> Processing station(s). Specifies the processing station(s) to be used for 

distributed processing. 
/r Redirect messages to file. Redirects messages from standard output to 

the specified file. Progress messages are not redirected. 
/n   none | 
       perScript | 
       perProcess 

No email notification. 
Only notify at the end of the script. 
Notify after each process of the script. 

Table 8: Command line operations summary. 
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14 EMAIL NOTIFICATION 

Users can be notified by email on the progress of processing. Depending on the operation being 
performed, the email notifications will include details about the inputs and the outputs. For aerial 
triangulation, the quality report will also be attached. 
 
This option can be activated in the “General Settings” from the “File” menu. Email account 
parameters and the list of recipients can be set in the corresponding “Email Configuration” dialog. 
These parameters are specified by the email provider. 
 
When executing a script, two types of status update are available: per script, and per process. If “per 
script” is selected, a notification will be sent only when the script is completed. If “per process” is 
selected, a notification will also be sent each time an operation is completed. 
 

While the default behavior is specified in the “General Settings” dialog, users can toggle 
the notifications directly in the progress bar during processing. 

 

14 
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15 TROUBLESHOOTING 15 



Troubleshooting | 124 

15.1 Log Window and Log File 

Correlator3D™ includes detailed warning and error messages to facilitate troubleshooting.  In 
addition, all major operations performed during processing are displayed in the log window.  This 
window is fully dockable, allowing the user to customize their Correlator3D™ environment.  
Warning and error messages are color-coded in yellow and red respectively. 

 
 

 
Figure 54: Log window. 

 
 
The content of the log window is automatically saved in a log file.  This can be particularly helpful if, 
for some reason, the processing is interrupted.  The file is located in the folder “My 
Documents\SimActive\Correlator3D\Logs” and named “Correlator3D_Log.xml”.  The file can also 
be accessed directly from the user interface by selecting “Log File” from the “Help” menu.  A new 
log file is created each time the software is launched and logs information until the program is closed.  
Copies of the twenty most recent log files are automatically stored in the same folder. 
 
 



Troubleshooting | 125 

15.2 Good Practice 

As a first step, the user should perform a test on a few images before processing an entire project.  
This will ensure that there is no problem with the input data.   It will also allow verifying that both 
the results and the required processing time meet expectations.  Input parameters (depending on 
the module used) can be varied, and small scale tests can be repeated until satisfactory results are 
produced.  Note that this recommendation does not hold for the aerial triangulation module, as it 
requires as much input data as possible. 
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15.3 Temporary Files 

Different temporary files are created during data processing.  In the case of the DSM generation 
process, each individual file, which is stored in the SimActive model format (.smf files), contains DSM 
generated from a given pair.  Temporary files are named according to the first image of the pair 
processed.  At the end of the DSM generation process, these individual files are automatically 
merged to produce a single DSM. 
 
If the DSM generation process is interrupted in the middle of a large batch process, then these files 
can be retrieved and merged manually using the DEM merging tool.  The user can change the 
location of the temporary folder by selecting “General Settings” from the “File” menu and changing 
its location.  For best software performance, this folder should be located on a separate local hard 
drive, different from the one where input/output data are stored. 
 
In the case of the fiducial detection process, a visual representation of the results is also created.  
For each input photo, an image showing the four detected marks is stored for visual validation.  
These images are named according to input image. 
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16.1 Camera Calibration Types 

 
Correlator3D™ supports four types of camera calibrations.  
 

1. Digital Sensors 
 
The first calibration type, designed for metric cameras, simply consists of providing the following: 
 

­ Image width in pixels 
­ Image height in pixels 
­ Pixel size in microns 
­ Focal length in millimeters 
­ Principal point coordinates in millimeters 

 
Note that the imagery is assumed to be already corrected for distortion. 
 

2. Digital Sensors with Distortion Table 
 
The second calibration type is meant to specifically support camera systems using a distortion table.  
The difference in the calibration file is that radial lens distortion is taken into account when 
processing imagery.  The parameter values are thus defined as a look-up table (LUT) .  These values 
specify radial distortion as a function of the pixel distance from the image center. 
 

3. Scanned Films 
 
The third calibration type, designed for scanned films, contains additional fields (compared to the 
digital sensor type) consisting of the coordinates in millimeters of the following: 
 

­ Bottom-left fiducial 
­ Top-right fiducial 
­ Top-left fiducial 
­ Bottom-right fiducial 

 
Positions of fiducials and the principal point should be referenced to the principal point of 
autocollimation as the origin.  
 

4. Polynomial  
 
The fourth calibration type specifically supports camera systems with radial and decentering lens 
distortion. The parametric distortion model is defined by the following equations, where X and Y 
are measurements in mm referring to the principal point and r=√(X2 + Y2):  
 

dX = dXradial + dXdecentering, 
dY = dYradial + dYdecentering, 
 

where, 
 

dXradial = X (K0 + K1*r2 + K2*r4 + K3*r6 + ... + K7*r14), 
dYradial = Y (K0 + K1*r2 + K2*r4 + K3*r6 + ... + K7*r14), 
dXdecentering = (1+P3*r2+P4*r4)*(P1*(r2+2*X2)+2*P2*X*Y), 
dYdecentering = (1+P3*r2+P4*r4)*(P2*(r2+2*Y2)+2*P1*X*Y), 
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and, 
 

K0 to K7 are parameters associated with the radial distortion, 
P1 to P4 are parameters associated with the decentering distortion. 
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16.2 Tile Definition File 

A tile definition file can be inputted in Correlator3D™ Mosaic Creation module to define the name, 
the coordinates and the size of each mosaic tile. A tile is defined by two corners located on the 
diagonal of its area. Each tile is specified on a separate line containing the following five (5) fields: 
 

­ Tile filename 
­ X coordinate of the first corner defining the tile area 
­ Y coordinate of the first corner defining the tile area 
­ X coordinate of the second corner defining the tile area 
­ Y coordinate of the second corner defining the tile area 

 

Corners can be specified in any order, as long as they are located on a diagonal. 

 
Sample: 
 
*********************************************************************** 
 SimActive Tile Definition File 
 Copyright(c) 2009 SimActive Inc. 
 All rights reserved. 
*********************************************************************** 
# Tile Name       First Corner (x,y) Second Corner (x,y) 
TileName_01  446762.0 5032005.0 447170.0 5031653.0 
TileName_02  447170.0 5032205.0 447643.0 5031415.0 
TileName_03  446862.0 5031653.0 447170.0 5031415.0 
TileName_04  447061.0 5031415.0 447351.0 5031120.0 
TileName_05  446762.0 5030920.0 447351.0 5031120.0 
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16.3 Script Format Description 

This section describes the operations and parameters available in a Correlator3D™ script. 
 
Script syntax is the following: 
 
<OperationName> 
{ 
 ParameterName ParameterValue 
 ParameterName ParameterValue 
 ... 
 ParameterName ParameterValue 
} 
 
The script file is case insensitive. This means that “DTMExtraction” and “dtmextraction” are both 
valid. The name of the operations must appear between ‘<’ and ‘>’ marks and the parameter lists is 
delimited by a pair of braces (‘{‘ and ‘}’). There is no limitation on the number of white spaces (spaces, 
tabs and new lines) as long as the ParameterName and its ParameterValue are on the same line. 
Comments can be added in the file. Each line of comment must be preceded with ‘#’.  
 
OperationName can be one of the following: 

 AerialTriangulation 
 DSMGeneration 
 DTMExtraction 
 Orthorectification 
 MosaicCreation 
 3DModelGeneration 
 ExportMosaic 
 Export3DModel 
 ChangeDetection 
 DEMMerging 
 DEMTiling 
 DEMInspection 
 ExportGeoidDEM 
 PointCloudColorization 
 DEMContourExtraction 
 DEMVolumeCalculation 
 ShareOnCesium 
 ExportMosaicSeamlines 
 ImportPointCloud 
 PointCloudFiltering 

 
The list of parameters and acceptable values varies according to the operation.  For a given 
operation, the order of the parameters has no importance.  The description of each available 
parameter follows. 
 

A sample script file is available in the software installation folder under “Sample 
Files\Script”. 
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Parameters for AerialTriangulation 
Parameter name Type Description 
TiePointExtraction ‘On’, ‘Off’ Indicates if tie point extraction must be performed. 
CameraCalibration ‘None’, ‘Constrained’, 

‘Unconstrained’ 
Indicates the type of camera calibration. 

EOAdjustment ‘None’, 
‘BoresightCalibration’,  
‘ConstrainedAT’, 
‘UnconstrainedAT’, 
‘Assisted’, 
‘OffsetCorrection‘ 

Indicates the type of EO adjustment. 

PerformBoresight ‘On’, ‘Off’ Bound boresight within total uncertainty. Only required if 
EOAdjustment is 'ConstrainedAT' 

ExtractionType ‘Standard’, ‘Exhaustive’ Type of tie point extraction to perform. 
ImageFiltering Float, 'None', 

'Automatic' 
Indicates the type of image filtering. 

InputEO String  Path to the input interior/exterior orientation file. 
GCPFile String  Optional. Path to the input ground control point file. 
InputDEM String Optional. Path to the reference DEM. Required for 

satellite projects. 
ReferenceORIList String Optional. Path to the reference ORI file. 
AdjustFocalLength ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 

bundle adjustment. 
AdjustXmm ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 

bundle adjustment. 
AdjustYmm ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 

bundle adjustment. 
AdjustK0 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 

bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK1 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK2 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK3 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK4 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK5 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK6 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustK7 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustP1 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustP2 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustP3 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustP4 ‘On’, ‘Off’ Optional. Indicates if parameter will be adjusted during 
bundle adjustment for odd/even order polynomial 
distortion model. 

AdjustLUT ‘On’, ‘Off’ Optional. Indicates if parameters will be adjusted during 
bundle adjustment for LUT distortion model. 
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AdjustX Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustY Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustZ Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustOmega Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustPhi Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustKappa Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustGCPXY Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustGCPZ Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

AdjustGCPObs Float Optional. Expected uncertainty in parameter to be 
adjusted during bundle adjustment. 

ATFolder String Path to the AT folder. 
OutputDEM String Path to the output coarse DEM file. 

 
 
Parameters for DSMGeneration 

Parameter name Type Description 
Projection String Projection of the DSM in the PROJ.4 format. Required 

for sensors other than frame-based. Invalid for frame-
based sensors since the projection is read from the input 
EO file. 

InputEO String Path to the input interior/exterior orientation file. 
Resolution Float, ‘Coarse’, 

‘Optimal’, 
‘Maximal’ 

Required resolution of the resulting DSM. 

VertAccuracy Float, ‘Optimal’, ‘Fast’, 
‘Precise’ 

Required vertical accuracy of the resulting DSM. 

OutputDEM String Path to the output DSM file. 
3DConstraintFile String Optional. Path to the 3D constraint file. 
GeneratePointCloud ‘On’, ‘Off’ Optional. Indicates if a point cloud must be generated. 
OutputPointCloud String Path to the output point cloud file. 
MaxNbImages Integer Optional. Between 2 and 6. Only if GeneratePointCloud 

is set to ‘On’. 
ColorizePointCloud ‘On’, ‘Off’ Optional. Indicates if the point cloud needs to be 

colorized. 
NbBands Integer, ‘Automatic’, Optional. Number of bands to be exported to the 

texture file. Must be commented out if TextureFormat is 
set to 'None'. 

BandAssign ‘OutputBandX = Y’ Optional. Required when NbBands is set to an integer. X 
corresponds to the output band number, and Y to the 
imagery band number. The band name can also be used 
for multispectral projects where each band has a name. 

BandAssign ‘OutputBandY = Z’ … 
BandAssign ‘OutputBandZ = X’ … 

 
 
Parameters for DTMExtraction 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
3DConstraintFile String Optional. Path to the 3D constraint file. 
ConstraintType 'Exclusion', 

'Elevation' 
Optional. Type of constraint to be used. 

DSMFeatures String Optional. Path to the output DEM. 
OutputDEM String Path to the output DTM file. 
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Parameters for Orthorectification 
Parameter name Type Description 
InputDEM String Path to the DEM file. 
InputEO String Path to the input interior/exterior orientation file. 
DSMBased ‘On’, ‘Off’ Parameter used to generate true orthos from a DSM. 
3DConstraintFile String Optional. Parameter used to generate true orthos using a 3D 

constraint file. 
OutputORIFolder String Path to the output folder. 
Resolution Float, ‘Optimal’, 

‘Coarse’ 
Required resolution of the orthorectified images. 

Overlap Integer, 
‘Optimal’, 
‘Maximal’ 

Required overlap between orthorectified images. Must be 
commented out if CropWidth and CropHeight are specified. 

BoundLeft Integer Crop percentage (0 to 99). Must be commented out if Overlap is 
specified. 

BoundRight Integer Crop percentage (0 to 99). Must be commented out if Overlap is 
specified. 

BoundTop Integer Crop percentage (0 to 99). Must be commented out if Overlap is 
specified. 

BoundBottom Integer Crop percentage (0 to 99). Must be commented out if Overlap is 
specified. 

UseSunSensor ‘On’, ‘Off’ Optional. Indicates if sun sensor must be used for reflectance. 
PanelFile String Optional. Path to the calibrated reflectance panel file. 
PanSharpening ‘On’, ‘Off’ Optional. Indicates if pansharpening is required. 
OutputFormat ‘GeoTIFF’, ‘TFW’ Output format of the orthorectified images. 
TiledTiff ‘Tiled’, ‘Untiled’ Indicates if the orthorectified images must be tiled or untiled. 
Overviews ‘On’, ‘Off’ Indicates if the orthorectified images must be generated with 

overviews. 
JPEGInTIFF ‘On’, ‘Off’ Indicates if JPEG compression must be used in TIFFs. 
BitDepth ‘8, ‘16’ or ‘32’ Optional. For 16-bit imagery, BitDepth can be set to 8 to 

downscale the bit depth. Otherwise, if specified, it must match 
the bit depth of the input imagery. 

 
Parameters for MosaicCreation 

Parameter name Type Description 
InputORIList String The default file name is the name of the IEO file used to 

orthorectify the images. 
MosaicArea String Optional. Path to the tile definition or vector file. 
OutputFolder String  Path to the output folder. 
MosaicName String Name of the mosaic. 
Feathering Integer Optional parameter. Default value is 37. 
MinNumBlocks Integer Optional parameter. Default value is 1. 
ColorBalancing ‘On’, ‘Off’ Indicates if color balancing must be applied. 
OptimizeViewAngle ‘On’, ‘Off’ Indicates if nadir optimization must be applied. 
ExclusionZone String Optional. Path to the vector file. The exclusion zone file is only 

considered when color balancing is on. 
InputDEM String Optional. Path to the DSM that constrains the seamlines. 

 
Parameters for 3DModelGeneration 

Parameter name Type Description 
InputPointCloud String Path to the point cloud file. Must be commented out if 

Input3DModel is specified. 
InputDEM String Path to the DEM file. Must be commented out if Input3DModel is 

specified. 
Input3DModel String Path to the 3D model file. Must be commented out if InputDEM is 

specified. 
InputEO String  Optional. Path to the input interior/exterior orientation file. Only 

required if GenerateTexture is 'On'. 
Output3DModel String Path to the output 3D model file. 
GenerateTexture ‘On’, ‘Off’ Indicates if texture must be generated. 
JPEGInTIFF ‘On’, ‘Off’ Optional. Indicates if JPEG compression must be used in TIFFs. 
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BitDepth ‘8, ‘16’ or ‘32’ Optional. For 16-bit imagery, BitDepth can be set to 8 to downscale 
the bit depth. Otherwise, if specified, it must match the bit depth of 
the input imagery. 

ModelSize Integer, 
‘Coarse’, 
‘Optimal’, 
‘Maximal’ 

Required size of the 3D model. Numerical values must be specified 
in megabytes (MB). 

 
Parameters for ExportMosaic 

Parameter name Type Description 
BlockDefFile String Path to the mosaic definition file. 
MosaicType ‘Standard’, 

‘Reflectance’, 
‘NDVI’, ‘BNDVI’, 
‘GNDVI’, ‘LCI’, ‘NDRE, 
‘SIPI’, ‘SIPI2, ‘ARVI’, 
‘GCI’, ‘NBR’, 'Custom' 

Type of the mosaic to be created. 

NbBands Integer, ‘Automatic’ Optional. Number of bands to be exported. Required when 
'MosaicType' is set to 'Standard' or 'Reflectance'. 

BandAssign ‘OutputBandX = Y’ Optional. Required when ‘NbBands’ is set to an integer. X 
corresponds to the index of the output band and Y to the 
index of the input band. Must be defined for each band 
(NbBands). For predefined mosaic types, supported values 
for 'BandAssign' include: Red, Green, Blue, RedEdge, NIR, 
and SWIR. Example: 
BandAssign Red = 2 
The band name can also be used for multispectral projects 
where each band has a name. 
BandAssign OutputBand4 = RedEdge 

IndexFormula String Optional. Only required if ‘MosaicType’ is set to ‘Custom’. 
Defines any operation between user-defined variables 
including addition, subtraction, multiplication, division, 
parenthesis, and use of constants. Consequently, 
‘BandAssign’ must be defined for all variables. Example:  
 
IndexFormula  ((Blue – Red ) / (Green + Red)) 
BandAssign  Blue = 1 
BandAssign  Red = 3 
BandAssign  Green = 2 

Colors ‘On’, ‘Off’ Optional. Only required if 'MosaicType' is not set to 
'Standard' or 'Reflectance'.  'On' will output an index map 
following the specified color map. 'Off' will output the 
floating point result of the index. 

UndefValue Float Optional. Value to be used for undefined pixels. Required 
when 'Colors' is set to 'Off'. 

ColorMap ‘Beige to Dark Green’, 
‘Dark Blue to Dark 
Green’, ‘DEM Color 
Style’, ‘Grayscale’, 
‘Red to Blue’ 

Optional*. The color map to be used. 

InvertColorMap ‘On’, ‘Off’ Optional*. Invert the color map. 
MinimumThreshold Float, ‘Optimal’ Optional*. Minimum bound of the NDVI index. 
MaximumThreshold Float, ‘Optimal’ Optional*. Maximum bound of the NDVI index. 
ClassCount Integer Optional*. Number of classes for the index. If omitted, the 

mapping is continuous. 
OutputFolder String Path to the output folder. 
ExportArea String Optional. Path to the area file. 
TileDefFile String Optional**. Path to the tile definition file. 
MosaicName String Optional**. Name of the output mosaic. 
TileWidth Integer Optional**. Tile width in pixels. Must be commented out if 

TileDefFile is specified or SingleTile is 'On'. 
TileHeight Integer Optional**. Tile height in pixels. Must be commented out if 

TileDefFile is specified or SingleTile is 'On'. 
SingleTile ‘On’, ‘Off’ Optional**. Indicates if the mosaic must be exported to a 

single tile. Must be commented out if TileDefFile is specified. 
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OutputFormat ‘GeoTIFF’, ‘TFW’ Output format of the mosaic tiles. 
TiledTiff ‘Tiled’, ‘Untiled’ Indicates if the orthorectified images must be tiled or untiled. 
Overviews ‘On’, ‘Off’ Indicates if the orthorectified images must be generated with 

overviews. 
JPEGInTIFF ‘On’, ‘Off’, ‘JPEG8’ Indicates if JPEG compression must be used in TIFFs. 'JPEG8' 

is used to convert imagery with more than 8 bits per band to 
8-bit JPEG-compressed TIFFs. 

*Must be defined when mosaic type is set to NDVI. 
**Either TileDefFile or MosaicName, TileWidth and TileHeight, or SingleTile can be specified. 
 
Parameters for Export3DModel 

Parameter name Type Description 
Input3DModel String Path to the 3D model file to be exported. 
TextureFormat 'TIFF', 'JPG' or 

'None'. 
The format of the texture to be exported. 

NbBands Integer, 
‘Automatic’, 

Number of bands to be exported to the texture file. Must be 
commented out if TextureFormat is set to 'None'. 

BandAssign ‘OutputBandX = Y’ Optional. Required when NbBands is set to an integer. X 
corresponds to the output band number, and Y to the 
imagery band number. The band name can also be used for 
multispectral projects where each band has a name. 

BandAssign ‘OutputBandY = Z’ … 
BandAssign ‘OutputBandZ = X’ … 
… … … 
Output3DModel String Path to the exported 3D model file. 

 
Parameters for ChangeDetection 

Parameter name Type Description 
ReferenceDEM String Path to the DEM file before the changes. 
ComparisonDEM String Path to the DEM file after the changes. 
MinimumThreshold Float Minimum detection threshold (in model units). 
MaximumThreshold Float Maximum detection threshold (in model units). 
OutputDEM String Path to the output DEM file. 
BlockDefFile String Optional. Path to the block definition file. 
OutputFolder String Optional. Path to the mosaic output folder. 

 
Parameters for DEMMerging 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
InputDEM String  
InputDEM String  
… … … 
FillGaps ‘On’, ‘Off’ Indicates if the gaps in the resulting DEM must be filled. 
OutputDEM String Path to the output DEM file. 

 
Parameters for DEMTiling 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
OutputFolder String Path to the mosaic output folder. 
TileDefFile String Optional*. Path to the tile definition file. 
DEMName String Optional*. Name of the output mosaic. 
TileWidth Integer Optional*. Tile width in pixels 
TileHeight Integer Optional*. Tile height in pixels 
OutputFormat 'GeoTIFF', 'AsciiGrid', 'SMF2Format', 

'SMFFormat', 'Shapefile', 'LIDARLAS', 
'LIDARLAZ' 

Format of the output DEM tiles. 

*Either TileDefFile or DEMName, TileWidth and TileHeight can be specified. 
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Parameters for DEMInspection 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
ReferenceData String Path to the reference data file. 
OutputFile String Path to the output statistics file. 

 
Parameters for ExportGeoidDEM 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
GeoidFile String Path to the geoid file. 
OutputDEM String Path to the output DEM file. 

 
Parameters for PointCloudColorization 

Parameter name Type Description 
InputPointCloud String Path to the input point cloud file. 
BlockDefFile String Path to the mosaic file. 
OutputPointCloud String Path to the output point cloud file. 
NbBands Integer, 

‘Automatic’, 
Optional. Output bands need to be provided if and only if 
“NbBands” is set to a numerical value. In this case, the number of 
provided “BandAssign” needs to match the number of bands 
“NbBands”. 

BandAssign ‘OutputBandX 
= Y’ 

Optional. X corresponds to the output band number, and Y to the 
imagery band number. The band name can also be used for 
multispectral projects where each band has a name. 

BandAssign ‘OutputBandY 
= Z’ 

… 

BandAssign ‘OutputBandZ 
= X’ 

… 

 
Parameters for DEMContourExtraction 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
Interval Float Interval between contours (in model units). 
Offset Float Offset from zero relative to which to interpret intervals (in model 

units). 
ElevationAttribute String Optional*. Name of the attribute containing the elevation. 
OutputFile String Path to the output contour file. 

 
Parameters for DEMVolumeCalculation 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
InputArea String Path to the area file. 
ReferenceType 'InterpolateDEM', 

'InterpolatePoly', 
'FixedElev', 'Dig', 
'Fill', 'RefDEM' 

The type of reference to be used to calculate volume. 

Offset Float Optional. Only used with 'Dig' and 'Fill' options. 
Elevation Float Optional. Only used with 'FixedElev' option. 
ReferenceDEM String Optional. Only used with 'RefDEM' option. 
OutputFile String Path to the volume report file. Both text files (.txt) and PDF files 

(.pdf) are accepted. 

 
Parameters for ShareOnCesium 

Parameter name Type Description 
ProfileName String Name of the Cesium profile. 
ProjectName String Name of the project. 
Projection String Optional. Projection of the project in the PROJ.4 format. 

Required for projects for which it was not previously 
defined. 
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InputPointCloud String Optional. Path to the point cloud file. 
InputDEM String Optional. Path to the DEM file. 
BlockDefFile String Optional. Path to the mosaic file. 
Input3DModel String Optional. Path to the 3D model file. 
NbBands Integer Number of bands to be exported to the texture file. The only 

accepted value is 3. 
BandAssign ‘OutputBandX = Y’ X corresponds to the output band number, and Y to the 

imagery band number. This parameter must be specified. The 
band name can also be used for multispectral projects where 
each band has a name. 

BandAssign ‘OutputBandY = Z’ … 
BandAssign ‘OutputBandZ = X’ … 

 
Parameters for ExportMosaicSeamlines 

Parameter name Type Description 
BlockDefFile String Path to the mosaic definition file. 
OutputFile String Path to the output seamline file. 

 
Parameters for ImportPointCloud 

Parameter name Type Description 
InputPointCloud String Path to the input point cloud file. 
InputPointCloud String  
InputPointCloud String  
… … … 
Resolution Float or 

‘Optimal’ 
Required resolution of the resulting DEM/Mosaic. 

OutputDEM String Path to the output DEM file. 
OutputFolder String Path to the output folder. 
MosaicName String Name of the mosaic. 

 
Parameters for PointCloudFiltering 

Parameter name Type Description 
InputPointCloud String Path to the input point cloud file. 
OutputPointCloud String Path to the output point cloud file. 
NumberOfObservations 2 = ‘On’, ‘Off’ Optional.The number of observations ranges from 2 up to 6. At 

least one "NumberOfObservations" must be set to 'Off'. If not 
specified, the number of observations is set to 'On' by default. 

NumberOfObservations 3 = ‘On’, ‘Off’  
NumberOfObservations 4 = ‘On’, ‘Off’  
NumberOfObservations 5 = ‘On’, ‘Off’  
NumberOfObservations 6 = ‘On’, ‘Off’  
MinimumElevation Float Optional. Minimum elevation 
MaximumElevation Float Optional. Maximum elevation 
ExportArea String Optional.Path to the area file. 
Keep ‘On’, ‘Off’ Optional. ‘On’ if the area must be kept, ‘Off’ if it must be excluded 

 
Parameters for Pansharpening 

Parameter name Type Description 
InputMultiImage String Path to the input multispectral image file. 
InputMultiRPC String Path to the input multispectral RPC file. 
InputPanImage String Path to the input panchromatic image file. 
InputPanRPC String Path to the input panchromatic RPC file. 
OutputFolder String Path to the output folder. 
OutputBaseName String Name of the pansharpened image and RPC files. 
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Parameters for SplatGeneration 
Parameter name Type Description 
InputEO String Path to the input interior/exterior orientation file. 
InputPointCloud String Path to the point cloud file. 
OutputFolder String Path to the output folder. 
OutputBaseName String Name of the splat model files. 
Quality ‘Fast’, 

‘Balanced’, 
‘Precise’ 

Quality of the resulting Gaussian splat model. 

 
 
 
Parameters for SplatMerging 

Parameter name Type Description 
InputSplat String Path to the input splat model file. 
InputSplat String  
InputSplat String  
… … … 
OutputSplat String Path to the output splat model file. 

 
 


